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2 About This Manual

2.1 Related Documentation

o Indexer 2 Program User Guide
o ASCII Interface Programmer’s Guide
« Parameter Dictionary

Kollmorgen software and related information can be found at:

www.kollmorgen.com

2.2 Copyrights

No part of this document may be reproduced in any form or by any means, electronic or mechanical, including
photocopying, without express written permission of Kollmorgen.

RGM WorkBench, is a registered trademark of Kollmorgen.

Windows 7, Windows 8, and Windows XP are registered trademarks of the Microsoft Corporation.

2.3 Document Validity

We reserve the right to modify our products. The information in this document is subject to change without
notice and does not represent a commitment by Kollmorgen. Kollmorgen assumes no responsibility for any
errors that may appear in this document.
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2.4 Product Warnings

Observe all relevant state, regional and local safety regulations when installing and using Kollmorgen
amplifiers. For safety and to assure compliance with documented system data, only Kollmorgen should
perform repairs to amplifiers.

A Hazardous voltages.

DANGER | Exercise caution when installing and adjusting Kolimorgen amplifiers.

Risk of electric shock.

On some Kollmorgen amplifiers, high-voltage circuits are connected to mains power. Refer to
hardware documentation.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-enables the PWM output
stage without operator intervention. In this case, motion may re-start unexpectedly. Configure
faults as latched unless a specific situation calls for non-latched behavior. When using non-
latched faults, be sure to safeguard against unexpected motion.

Latching an output does not eliminate the risk of unexpected motion with non-latched
faults.

Associating a fault with a latched, custom-configured output does not latch the fault itself. After
the cause of a non-latched fault is corrected, the amplifier re-enables without operator
intervention. In this case, motion may re-start unexpectedly.

For more information, See "Faults" (= p. 35).

When operating the amplifier as a CAN, the use of RGMWorkBench or ASCII serial commands
may affect operations in progress. Using such commands to initiate motion may cause network
operations to suspend.

Operation may restart unexpectedly when the commanded motion is stopped.

Use equipment as described.

Operate amplifiers within the specifications provided in the relevant hardware manual or data
sheet.

FAILURE TO HEED THESE WARNINGS CAN CAUSE EQUIPMENT DAMAGE,
INJURY, OR DEATH.

2.5 Revision History

Revision Date Applies to Comments
00 November 2017 RGM WorkBench V8.0 Beta 1
A June 2018 RGM WorkBench v8.0 Beta 7 Initial Release
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3 Introduction

3.1 Host Computer Requirements

3.1.1 Computer and Operating System

Minimal hardware requirements:

« CPU:1GHz
« RAM: 1GB

Operating Systems Supported: Windows XP, Windows 7 and Windows 8.

3.1.2 Default File Locations
The default location for RGM WorkBench data files (ccx, ccm, etc.) is determined by the Operating System.
Windows XP:

C:\Program Files\Kollmorgen Motion\RGM WorkBench
Windows 7 and Windows 8

C:\Users\Public\Documents\Kollmorgen Motion\RGM WorkBench

3.1.3 Serial Communications

« Standard RS-232 serial port or a USB-t0-RS-232 adapter.
« Serial communication cable. See data sheet for part numbers.

3.1.4 CAN Communications
The following CAN card manufacturers are supported:

« Kvaser

3.2 RGM WorkBench Overview

3.2.1 Setup and Tuning

Java based RGM WorkBench configuration software is powerful and intuitive. Comprehensive diagnostics,
auto-tuning and advanced oscilloscope tools simplify system commissioning. Auto-phasing eliminates time
consuming rewire-and-try for encoder/Halls/motor connections. RGM WorkBench automatically
compensates for crossed wires eliminating the most common cause of startup headaches.

3.2.2 Indexing

Point-and-click to define up to 32 indexes or index sequences. Simply select the index/sequence and
command GO. Index sequences can include motion, parameter changes, dwell times and 1/O control. Any
parameter can be assigned to a register for efficient control by a PLC.

Custom functions can be provided for complex applications. Install the Java "bean" and fill in the blanks.
Kollmorgen also provides a flexible OEM programming environment. Kollmorgen Virtual Machine
assembler/debugger enables the development of fast, compact control program.
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3.3 Servo Operating Modes and Control Loops

3.3.1 Servo Operating Modes and Control Loops

Kollmorgen drives use up to three nested control loops - current, velocity, and position - to control a motor in
three associated operating modes.

3.3.2 Control Loops Model

In position mode, the amplifier uses all three loops. As shown in the typical system illustrated below, the
position loop drives the nested velocity loop, which drives the nested current loop.

Limits
Target Position Velocity Limited Current Limited PWM
Position il Command Command | Velocity Command | Current Command
) : - : — @ — = ; ;
Trajectory . Position + | Velocity | « a; Vilocny :a . Current ' Current . Motor/
oop

Generator Loop Limiter ' g Limiter Loop Sensors
’_A:tual Position ’_;erived Velocity ’—:\ctual Current

In velocity mode, the velocity loop drives the current loop. In current mode, the current loop is driven directly
by external or internal current commands.

3.3.3 Basic Attributes of All Servo Control Loops
Loop Description
Attribute

Command | Every loop is given a value to which it will attempt to control. For example, the velocity loop
input receives a velocity command that is the desired motor speed.

Limits Limits are set on each loop to protect the motor and/or mechanical system.

Feedback | The nature of servo control loops is that they receive feedback from the device they are
controlling. For example, the position loop uses the actual motor position as feedback.

Gains These are constant values that are used in the mathematical equation of the servo loop. The
values of these gains can be adjusted during amplifier setup to improve the loop
performance. Adjusting these values is often referred to as tuning the loop.

Output The loop generates a control signal. This signal can be used as the command signal to another
control loop or the input to a power amplifier.

For more information on using RGM WorkBench to set up and tune control loops, see "Control Loops" (= p.
45).
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4 Installation, Startup, and Interface Tour

4.1 Download and Install RGM WorkBench Software

1. Navigate to:
www.kollmorgen.com
Select RGM WorkBench to start the download.

2. Navigate to the folder where RGM WorkBench was downloaded to and extract the contents of RGM
WorkBench.zip.

3. Run Setup.exe and follow the instructions on the installer screens. We recommend accepting all
default installation values.

4.1.1 Installer

When the installer starts, Windows will display a dialog asking for permission to make changes to your
computer. Click the button to allow the installer to continue, and RGM WorkBench will be installed properly.
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4.1.2 Set up RGM WorkBench to run as administrator

On some versions of Windows 7 and Windows 8, RGM WorkBench will have to be set up to run as
administrator to access the communications drivers (serial, CANopen, EtherCAT).

—_

et Right-click the RGM WorkBench icon on the desktop.
2. Choose Properties from the pop-up menu.

Open

Open file location

Enable/Disable Digital Signature lcons
®) Run as administrator

Troubleshoot compatibility

Pin to Start

Pin to taskbar

Send to >

Cut
Copy

Create shortcut
Delete

Rename

Properties

3. Click the Advanced button on the Properties dialog.

%8 RGM Workbench Properties *

Security
General

Target type:

Details
Shortcut

% RGM Workbench

Application

Previous Versions
Compatibility

Target location: RGM Workbench

Target: | m Files'Kollmorgen RGM Workbench ' RGM exe" |

Start in: |"C:'-.Pn:|gram Files"Kollmorgen ' RGM ‘.‘\4'0rkbench"|

Shortcut key: | Mone |

Run: MNomal window ~
Comment: || |
Open File Location Change Icon... | Advanced...
Concdl | T Forly
4. Select Runas Administrator. Click OK to close the Advanced Properties dialog, then OK to close the
Properties dialog.
Advanced Properties *

D Choose the advanced properties you want for this shortcut.

(" []Run as administrator

This optian aﬂai\"é';'.ou to run this shortcut as an
administrator, while protecting your computer from
unauthorized activity.

Run in separate memory space

Cancel
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4.2 Start RGM WorkBench

™
1. s Double-click the RGM WorkBench shortcut icon on the Windows desktop to start RGM

WorkBench.

o | If communications were set up already... If communications were not set up...
...the RGM WorkBench Main Screen opens. If ...the Communications Wizard will be displayed
there are multiple ports, Kollmorgen as shown below:

Neighborhood will be selected in the tree as
shown below: Communications Wizard *
2 RGM Workbench V8.0 Beta 6 Select Device:
File Amplifier Tools Help ®
BOCEMm O mren
Bl Ji Kollmorgen Neighborhood () EtherCAT
Lo BB Virtual Amplifier
= COM1: H-Axis Mext = Cancel
Select the desired drive: In this case, proceed to "Communications

Wizard" (= p. 14)

=~ JJ Kollmorgen Neighborhood
- KB Virtual Amplifier

L COMZ: Y-Asxis

After an amplifier has been selected, the RGM WorkBench Main Screen looks similar to this:
m RGM Workbench V8.0 Beta 6 (801-1896 X-Axis) — O *

FLEL

File Amplifier Tools Help

SOOMM « B

- §) Kollmorgen Neighborhoo
- EEB Virtual Amplifier

LK COM2: Y-Axis

CVM Control Program

CAN Configuration |~ P Loop =—# V Loop | | Loop | Motor

L =]

Axis A

@ Home Configure Faults
Axis B
Axis C Configure Filters
Axis D
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4.3 Communications Wizard

4.3.1 Configure Serial Ports

1. Start the Communications Wizard

If communications has never been set up, the Communications Wizard will be displayed automatically
when RGM WorkBench starts up.

Communications Wizard *

(O) CAN Network

() EtherCAT

Mext = Cancel

Otherwise choose Tools=>Communications Wizard
Choose Serial Ports and click Next
2. Select serial ports

Select one or more serial ports from the Available Ports list then click Add.

Communications Wizard *

Select Ports

To add serial ports, select them from the Available Ports list, then press Add.

To remove serial ports, selectthem from the Selected Ports list, then press Remove.

Available Ports: Selected Ports:
comMz2 COM1

= Remove

< Back Mext = Cancel

When finished, click Next.
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3. Configure serial ports
« Highlight a port in the Selected Ports list.

Communications Wizard *

Configure Serial Ports

Select one or more serial ports from the list, then select the baud rate.

Selected Ports:

Baud Rate: | 115200 w

= Back

Cancel

« Choose a Baud Rate for that port.
« Repeat for each selected port.

Click Finish to save the settings.
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4.3.2 Configure CANopen Network

1. Start the Communications Wizard

If communications has never been set up, the Communications Wizard will be displayed automatically
when RGM WorkBench starts up.

Otherwise choose Tools-> Communications Wizard

Communications Wizard *

Select Device:

() Serial Parts

() EtherCAT

Mext = Cancel

Choose CAN Network and click Next

2. Configure CAN Network
« Select the CAN card from the list.
« Enter the channel number (0 for single channel CAN cards).
« Select the bit rate.

Communications Wizard x|

Configure CAN Network

CAN Interface: IKvaser VI
Channel: ID
Bit Rate: I].Mb\tfs VI

[~ Use LSS to Configure Node Ids

< Back | Cancel |

Click Finish to save the settings.

NOTE
1. The CAN Card list only shows the CAN cards that are supported by RGM WorkBench and are prop-

erly installed on the PC.
2. All amplifiers must be set to the same bit rate (default is 1 Mbit/s).
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4.4 Connectto an Amplifier

Choose an amplifier by clicking on its name in the Kollmorgen Neighborhood. When there is only one
amplifier, RGM WorkBench will automatically connect on startup.

One serial port Multiple serial ports CAN network

2 RGM Workbench V8.0 Beta 6 | | B8 RGM Workbench V2.0 Beta 6 2 RGM Workbench V8.0 Beta 6

File Amplifier Tools Help File Amplifier Tools Help File Amplifier Tools Help

SOOEM|BOCOEM « OO EM

- | Kellmergen Neighberhood [El- ) Kelimorgen Neighborhood | Kollmorgen Meighberhood
- KB Virtual Amplifier - KB Virtusl Amplifier - KB Virtusl Amplifier

.- ] M E COMA: -2 - I CANT: X-Axis

4.5 Rename an Amplifier

1. Choose Main Menu Amplifier-Rename to open the Rename Amplifier screen.

Rename Amplifier x|

Enter the new name:

oK | Cancel |

2. Enterthe new name and click OK to close the screen.
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4.6 RGM WorkBench Interface Tour

RGM WorkBench features are called out in the diagram below. Screen details vary depending on amplifier
model and mode selection. Details follow in the chapter.

T8 RGM Workbench V2.0 Beta § (201-1896 X-Axis) _ o x
m:rm File Amplifir Tools Help
$#OO WM+ L) om0 4 [ Toobar |
=I- JJ Kollmergen Neighborhoo
Kollmorgen | g L
Neighborhood = -
Tree

CVM Control Program Functional
Diagram

CAN Configurstion  —b| P Loop — VLoop —b| ILoop —H Moter /

Axis | @ aesa Home Gonfigure Faulls
Selection Axis B

Axis C Canfigure Filters

Axis D

I Status Bar I

4.6.1 Tool Bar

Icon Name For More Information

a Basic Setup "Basic Setup" (= p. 23)

@ Control Panel "Control Panel" (< p. 74)

Auto Phase "Motor Phasing" (= p. 38)

E Scope "Oscilloscope" (= p. 79)

m Frequency Analysis "Frequency Analysis" (= p. 101)
. Error Log "Error Log" (= p. 112)

Amplifier Properties

Save amplifier data to disk "Data Management Tools" (= p. 108)

Restore amplifier data from disk

Save amplifier data to flash

Restore amplifier data from flash
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Menu Selection Description For More Information
File Save Drive Con- | Saves contents of amplifier RAM and | "Data, Firmware, and Logs" (= p.
figuration (.ccd) |all CVM flash to a drive configuration | 107)
file.
Save Amplifier |Saves comtents of amplifier RAM to
Data (.ccx) afile on disk.
Save As Saves amplifier data file in format
usable by RGM WorkBench
Restore > Drive |Restores contents of a drive con-
Configuration figuration file to amplifier RAM and
(.ccd) CVM flash.
Restore Restores contents of an amplifier file
> Amplifier Data |from disk to amplifier RAM.
(.ccx)
Restore > CVM | Restores a CVM program from afile | Kollmorgen Indexer 2 Program User
Control Program |to the CVM Flash. Guide.
(.ccp)
Restore > Gain | Restores Gain Scheduling Table from | "Gains Scheduling” (= p. 115)
Scheduling afile (.ccq).
Table(.ccq)
Exit Closes RGM WorkBench
Amplifier | Setup Opens Setup screen. "Basic Setup" (= p. 23)

Control Panel

Opens Control Panel.

"Control Panel" (= p. 74)

Auto Phase Opens Auto Phase tool. "Motor Phasing" (= p. 38)
Scope Opens Scope Tool screen. "Oscilloscope" (= p. 79)
Frequency Ana- | Opens Frequency Analysis screen "Frequency Analysis" (= p. 101)
lysis

Error Log Opens Error Log screen. "Error Log" (= p. 112)

Amplifier Prop-
erties

Displays basic amplifier properties

Network Con-
figuration

Opens the CAN Configuration screen

"Network Configuration" (=» p. 34)

Rename

Prompts for new amplifier name

"Rename an Amplifier" (= p. 17)

Gain Scheduling

Opens Gain Scheduling screen

"Gains Scheduling" (= p. 115)

Kollmorgen | kdn.Kollmorgen.com | February 2019




RGM WorkBench User Guide | 4 Installation, Startup, and Interface Tour

Selection

For More Information

Description

Tools Communications | Starts sequence of prompts to set up |"Communications Wizard" (= p. 14)
Wizard communications.
Communicaitons | Opens Communications Log. "Communications Log" (=» p. 113)
Log
Download Firm- | Starts prompts to download firmware |"Firmware Download" (< p. 111)
ware from disk to amplifier.
Manual Phase | Opens Manual Phase tool. "Manual Phase" (= p. 42)
View Scope Opens Trace Viewer window. "Scope Trace Files" (= p. 91)
Files
RGM Opens screen for locking and unlock- | Lock/Unlock CME
WorkBench ing RGM WorkBench functionality.
Lock/Unlock
ASCIl Com- Opens screen to accept ASCII Kollmorgen ASCII Interface
mand Line format commands.
Login Needs Definition
Help RGM Opens this manual
WorkBench
User Guide

All Documents

Opens the Doc folder in the RGM WorkBench installation folder (typically
c://Program Files/Kollmorgen/RGM WorkBench/Doc). This folder contains
all of the related documents that were installed with RGM WorkBench.

Downloads Web
Page

Software Web
Page

Opens default web browser with pages from Kollmorgen website.

View Release
Notes

Opens latest RGM WorkBench release notes in a text viewer.

About

Displays RGM WorkBench version information.
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4.6.3 Functional Diagram

The functional diagram, shown below, provides button-click access to most of the screens used to configure
an amplifier. It also indicates the flow of control from input, across all active control loops, to motor/feedback.
Only those control loop buttons that are appropriate to the amplifier and operational mode appear on the

diagram.
Control Loops

CVM Control Program | |

| | |
CAN Configuraticn P Loop |—$| V Loop [—| | Loop Motor
T : |

Home Configure Faults

Configure Filters

Name Description For More Information
CVM Control Opens Kollmorgen Virtual Machine screen. | Kollmorgen Indexer Program User’s
Program Guide.
Control Loops Each opens a control loop configuration "Control Loops" (= p. 45)
screen.
Motor Opens the Motor screen. "Motor" (=¥ p. 29)
Home Configure and test homing. "Homing" (= p. 69)
Configure Faults Opens Fault Configuration screen. "Faults" (= p. 35)
Configure Filters Opens Filter Configuration Screen "Filters" (=» p. 93)
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4.6.4 CAN Information and Status Bar

4.6.4.1 CAN Information

The Main screen displays the basic CAN information. The example below shows CAN information:

CAMN Metwork:  Address: 1 State: Pre-operational

The Address field shows the amplifier's present CAN address. For more information, see "Network
Configuration" (=» p. 34) . When the Position Loop Input is set to CAN, the State field shows the state of the
amplifier's CANopen state machine (for more information, see Kollmorgen’s CANopen Programmer’s
Manual).

4.6.4.2 Status Bar

The status bar describes the present commutation mode, motor type, and amplifier control status as shown
below. It also includes a reminder that pressing the F12 function key while RGMWorkBench is running
disables the amplifier.
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5 Basic Setup

5.1 Basic Setup Overview

The Basic Setup Wizard is used to set up the parameters that define the fundamental characteristics of the
system. This is where the motor, feedback, and operating mode are setup. The setup can be done three
different ways: manually change settings, load settings from a ccx file, or run the ServoTube setup wizard.
Each of these methods are explained in this chapter.

1. aCIick to open the Setup screen.

Setup
Settings
Motor Family: Brushless
Motor Type: Rotary
Commutation: Sinusoidal
Hall Type: Digital
Hall Phase Correction: on
Use Halls for Velocity/Position: Off
Use Back EMF for Velocity: Off
Motor Feedback: Primary Incremental
Load Feedback: BiSS
Load Feedback Type: Rotary
Multi-mode Port: Buffered Primary Feedback
Operating Mode: CAN
Load ccx File Load ccd File Cancel
2. Change settings.
3. Choose:
Change Settings . . .
. Click Change Settings to manually "Change Setup Settings" (= p. 24).
OR
Load ccx File

If you have a .ccx file that was prepared for the amplifier/motor combination,
click Load ccx File and see "Data Management Tools" (= p. 108).
OR

. Lﬂall To accept the displayed settings, click Cancel.
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5.2 Change Setup Settings

1 [ Change Settings

] On the Basic Setup screen, click Change Settings to manually change all Basic

Setup settings. Use the Back and Next buttons to navigate screens.

2. Set Motor Options

Setup

Motor Options

Motor Family:
(®) Brushless (_) Brush

Motor Type:
(® Rotary (O Linear

[ vertical

*

< Back Mext = Cancel

3. Set Feedback Options

Setup

Feedback Options
Hall Type: | Digital w

]

Motor Feedback: | Incremental

Load Feedback: | BiSS

Load Feedback Type:
(® Rotary () Linear

[ Use Load Feedback In Passive (Monitor) Made

Input Source:
~ | (@ Primary (_) Secondary

~ Primary (@) Secondary

< Back Mext = Cancel

Setting Description

Hall Type Select Hall type: None, Digital.
Hall Phase Cor- If selected, will enable error checking between hall sensors and encoder
rection phase angle.
Motor Feedback Select type and source of motor feedback.
« Incremental
o Primary Incremental: Incremental encoder on primary feedback con-
nector.
Load Feedback Select type and source of Position (load) feedback.
« nNone
. BiSS
Load Feedback Type | Select the type of Position (load) feedback:
« Rotary

Use Position Encoder
in Passive (Monitor)
Mode

When this is checked, the position of the position encoder will be reported by
the passive load position variable but it will not be used to control the position
of the axis.
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4. Set Motor Feedback Options

Setup *
Motor Feedback
4436 | lines = 17944 counts
< Back Cancel

Model Lines
RGM 14 4130
RGM 17 4274
RGM 20 4486
RGM 25 5342

5. Set Load Feedback Options

Setup *

Load Feedback

Basic Settings  Advanced Settings

Bits: 19 = 524288 counts per rev
Mumber of Revolutions: 1| turns
Mumber of Alignment Bits: 1]

()BiSSB @ BiSSC

Ratio
Motor Turns: 101 Load Turns: 1
< Back Cancel

Bits 19
Number of Revolutions 1 tun
Number of Alignment Bits 0
Biss Biss C
Ratio
Motor Turns 101
Load Turns 1

Kollmorgen | kdn.Kollmorgen.com | February 2019




RGM WorkBench User Guide | 5 Basic Setup

6. Set Brake/Stop Options

Setup *

otor Wiring Detection

'
Enable Input —|-1—P-E BrakesStop delay time
'
H
T
Speed g
Y i Brake!Stop activation velocity

Brake Cuptput

Enable - AN celay s
Powver Section Brake!Stop response time:

Brake/Stop Delay Time: 250 | ms
Brake/Stop Activation Velocity: 0.1 rpm
PWM Delay Brake/Stop Response Time: 150 | ms
< Back Mext = Cancel

7. Set Operating Mode Options

Setup *

Operating Mode Options
Operating Mode: | Position w
Command Source: | Software Programmed w

Digital Input Source
(®) High Speed Inputs

Multi-mode Port

Mext = Cancel

Setting Description

Command | CAN Command input is provided over the CANopen network. See the
Source CANopen Programmer's Guide.

Function Internal function generator provides the command input.
Generator

Software The amplifier is controlled by software commands from either the Koll-
Programmed | morgen Virtual Machine (CVVM) or an external source. See Kollmorgen
Indexer Program User’s Guide or the Kollmorgen ASCII Interface Pro-
grammer’s Guide.
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8. Set Miscellaneous Options

Setup

Miscellaneous Options

Commutation Mode:

(®) Sinusoidal (C) Trapezoidal () Estimated Sinusoidal

Use Back EMF For Velodty

Use Halls for Velodty

Multi-mode Port: | Differential Input

Mext = Cancel

Setting Description
Commutation | Commutation method: Sinusoidal, Trapezoidal, or Estimated Sinusoidal

9. When changes are complete, click Finish.
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5.3 Brake/Stop Parameters

Many control systems employ a brake to hold the axis when the amplifier is disabled. On brake-equipped
systems, disabling the amplifier by a hardware or software command starts the following sequence of events.

1. The motor begins to decelerate (at Abort Deceleration rate in position mode or Fast Stop Ramp rate in
velocity mode). At the same time, the Brake/Stop Delay Time count begins. This allows the amplifier
to slow the motor before applying the brake.

2. When response time has passed, the amplifier's output stages are disabled. This delay ensures the
brake has time to lock in before disabling the power section.

3. This feature is not available when the amplifier is configured for current mode. In this mode, the amp-
lifier output turns off and the brake output activates immediately when the disable command is
received.

4. This feature is available when a fault is activated.

Setup *

Motor Wiring Detection

'
Enable Input —|-1—P-E BrakesStop delay time
'
H
0
Speed i
Y i Brake!Stop activation velocity
'
'
'

Brake Cuptput

Enzble E"-P Pt clelay s

Povwver Section E BrakesStop response time
Brake/Stop Delay Time: 250 | ms
Brake/Stop Activation Velocity: 0.1 rpm
PWM Delay Brake/Stop Response Time: 150 | ms

< Back Next > Cancel
Parameter Description
Brake/Stop Delay Time Range of accepted values: 0 to 10,000 mS
Brake Activation Velocity Range of accepted values: 0 to encoder resolution dependent limit rpm
(mm/s for linear motor)

PWM Delay Brake/Stop Range of accepted values: 0 to 10,000 mS

Response Time

Sets the three brake parameters to defaults values, based on the motor

data.
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6 Motor

6.1 Motor Data Screen Overview

m Motor Data _ O %
Manufacturer: | Koll Units
Use Rated Data anu rer morgen
(®) Use Specification Data Model: RGM14 @ Metric () English
Number of Poles: 16 Torque Constant:
0.1 [N'mfapk
Motor Inertia:
0.154 | kg-cm? ~ Back emf Constant:
9.41| |Vkpm v
Peak Torgue:
141 N'm -~ Resistance: 0.68 | ohms
Continuous Torgue: Inductance: o 55| mH

0.58 N'm -

Velocity Limit: 4500 | rpm

SIEE

Close

Action Name Description
Restore motor data from | Restores contents of a .ccm file from disk to PC.
disk

Save motor data to disk | Saves motor/feedback/brake settings from PC to a disk file with .ccm
name extension.

Save motor data to flash | Saves motor/feedback/brake settings from PC to amplifier permanent
flash memory.

Calculate Calculates initial tuning and limit values.

Motor
1. —l Click Motor to open the Motor screen.

2. "Load Motor Settings from a File" (=» p. 30) data from disk.

D) % | B

OR

Enter settings manually:

Motor
1. Click the Motor tab to view or change Motor Data.

2. . Click "Calculate" (=» p. 31) to calculate initial gains and limits.

3. -" On the Main screen, click Save to Flash to avoid losing the changes.
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6.2 Load Motor Settings from a File

Load the motor data to the amplifier.

Motor
1. —l Click Motor to open the Motor screen.

2. On the Motor screen, click Restore Motor Data from Disk.
3. When prompted, navigate to the folder containing the file, then click on the file name, and then click
Open.

4. . Calculate initial gains and limits with.

5. -_ On the Main screen, click Save to Flash to avoid losing the changes.

6.3 Motor Parameters

Setting Description

Manufacturer | Motor manufacturer's name. Saved for reference in the motor data file.

Model Motor model number. Saved for reference in the motor data file.

Units Selects whether the parameters entered in this screen are in Metric or English units.

Motor Inertia | The rotor inertia of the motor. Used for calculating initial velocity loop tuning values.
Range: 0.00001 to 4,294 kg cm2. Default: 0.00001 kg-cm?2-

Numberof | The number of magnetic poles in the motor. Required for correct commutation of the motor. If
Poles the number of poles is not known,

Verify the motor’s pole count using the "Data accuracy test" (= p. 44).. Range: 2 to 200.
Default: 4.

Peak Torque | The peak torque that the motor can produce. Peak Torque divided by torque constant =
motor’s peak current limit. Range: 0.0001 to 2,100 Nm. Default: 0.0001 Nm.

Continuous | The continuous torque that the motor can produce. Used with the torque constant to cal-

Torque culate continuous current. Range: 0.0001 to 1,000 Nm. Default: 0.0001 Nm.

Velocity Maximum speed of the motor. Used to calculate the velocity and acceleration limits for the
Limit velocity loop. Range dependent on encoder resolution.

Torque Con- | Relates the motor's input current to torque produced. Sometimes abbreviated as Kt.

stant Range: 0.001 to 1,000 Nm/Apk. Default: 0.001 Nm/Apk.

Back emf Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used for
Constant calculating the maximum velocity for a given amplifier bus voltage.

Range: 0.01 to 21,000,000 V/Krpm. Default: 0.01 V/Krpm.

Resistance |Motor resistance line-to-line. Used for calculating the initial current loop tuning values.
Range: 0.01 to 327 Q. Default: 0.01 Q.

Inductance | Motorinductance line-to-line. Used for calculating the initial current loop tuning values.
Range: see the hardware documentation.
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6.4 Calculate

The Calculate function uses the motor and feedback data to calculate initial gains and limits. These can be
modified to fine-tune the amplifier. Follow the steps below:

&
1. £l Click Calculate to calculate and display settings.
Calculated Amplifier Settings @
-~
Current Loop Cp Gain: 3426 =
Current Loop Ci Gain: 571
Peak Current Limit 9.64 A =
Continuous Current Limit 3.85 A
12T Time Limit 1000 ms
Current Loop Offset 1] A
Current Ramp: 1] mas
Programmed Current: [u] A
Velodty Loop Vp Gain: 3144
Velodty Loop Vi Gain: 699
Velodty Integral Drain: 1]
Velodty Loop Velocity Limit: 2250 rpm
Velodty Loop Accel., Decel., Fast Stop: 750 rps?
Velodty Tracking Window: 9375 rpm
Velodty Tracking Time: 100 ms x

2. Verify the peak current limit, continuous current limit, and velocity loop velocity limit.

If one or more of these values seems inappropriate, click Cancel and check: Peak Torque, Continuous
Torque , Velocity Limit, and Torque Constant. Correct them if needed. See "Motor Parameters " (= p.
30).

If the Motor/Feedback values were correct but the peak current limit, continuous current limit, or
velocity loop velocity limit values are not optimal for the application, change these limits during the
tuning process.

3. Save the values into amplifier RAM by clicking OK.

NOTE

When loading motor data from a file, if the motor wiring configuration in the motor file does not match
the configuration currently stored in the amplifier, CME prompts for verification on which configuration
to use. Select the file configuration by clicking Yes. The configuration will be tested as part of "Motor
Phasing" (= p. 38).

4. -“ On the Main screen, click Save to Flash to avoid losing the changes.
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7 Command Inputs

7.1 Software Programmed Input Settings

These settings can be saved to flash to allow default conditions to be set and used when the amplifier is
powered up or reset.

7.1.1 Programmed Position

Programmed Position

. Click the Programmed Position button on the Main screen.
% Programmed Comma... — X
Move: Type:
(®) Relative (@ Trap
() Absolute () 5 Curve

Distance: 69905 | counts

Close

Setting Description

Move Relative or Absolute.

Type Trap or S-Curve.

Distance |Move distance (relative) or location (absolute)
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7.1.2 Programmed Velocity

Programmed Velocity . . .
. Click the Programmed Velocity button on the Main screen.

ﬁProgrammed(nmmand o [l 3
Programmed Velocity: I 0 rpm

K o |

A Potential for unexpected movement.

DANGER | |f the Programmed Velocity is set to values other than 0, the motor will move after power-up or
reset if the amplifier is hardware enabled.

Failure to heed this warning can cause equipment damage, injury, or death.

Description

Programmed Velocity Move velocity. Units: rpm (rotary) or mm/s (linear).

7.1.3 Programmed Current

Programmed Cument

| Click the Programmed Current button on the Main screen.

i

Programmed Current: I 0| A
Current Ramp: I 1000 mAjs

Close |

A Potential for unexpected movement.

DANGER | f the Programmed Current is set to values other than 0, the motor will move after power-up or
reset if the amplifier is hardware enabled.

Failure to heed this warning can cause equipment damage, injury, or death.

Setting Description

Programmed Current | Current applied during the constant velocity portion of the move. Units: A.

Current Ramp Acceleration/deceleration current. Units: mA/s.
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8 Network Configuration

8.1 CANopen Network

A CANopen network can support up to 127 nodes. Each node must have a unique and valid seven-bit address
(Node ID) in the range of 1-127. (Address 0 should only be used when the amplifier is serving as a RGM
WorkBench serial port multi-drop gateway.)

1. Verify that the CAN network has been cabled and terminated as per amplifier documents.
2. Toopenthe CAN Configuration screen, choose Amplifier->Network Configuration.)

m RGM Workbench V8.0 Beta 6 (301-18

File = Amplifier Tools Help

a Setup

B[] Control Panel
Auto Phase
Scope
Frequency Analysis
Error Log
Amplifier Properties
MNetwork Configuration

Rename

Gain Scheduling

3. Choose a Bit Rate and choose any combination of address sources (Inputs, and Programmed Value).
The address is the sum of the values from these sources.

CAN Configuration *
Input Mapping
Bit Rate: ~ Number of Inputs: |0
Address Configuration
Use Switch Bit 0:
[ Use Inputs Bit 1: |None
Use Programmed Value Bit 2: |None
it 3
Switch Value: ot 3:
Input Lines Value: Bit 4: |None
Programmed Value: & Bit 5: [ Nome
Mew Resulting Address:
Bit 6: | None
Save & Reset Save & Close Cancel Help

4. Foreach source selected, perform the additional steps described below.

Source Additional Steps

Use Inputs Enter Number of Inputs, then choose inputs to represent each CAN address
bit.

Use Programmed Enter the Programmed Value.

Value

5. Click Save & Reset to save changes to amplifier flash, close the screen, and reset the amplifier. Click
Save & Close to save changes to amplifier flash without resetting.

NOTE

Address and bit rate changes take effect only after power-up or reset.
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9 Faults

9.1 Faults Overview

9.1.1 Latched vs Non-latched Faults

When a fault is configured to be latched, the fault can only be cleared after the fault has been corrected and at
least one of the following actions has been taken:

« Power-cycle the amplifier

« Cycle (disable and then enable) an input that is configured as Enable with Clear Faults or Enable with
Reset

« Open the Control Panel and press Clear Faults or Reset

o Clear the fault over the CANopen network or serial bus

A non-latched fault will be cleared when the fault condition has been removed. This can occur without
operator intervention.

A Risk of unexpected motion with non-latched faults.

DANGER | After the cause of a non-latched fault is corrected, the amplifier re-enables the PWM output
stage without operator intervention. In this case, motion may re-start unexpectedly. Configure
faults as latched unless a specific situation calls for non-latched behavior. When using non-
latched faults, be sure to safeguard against unexpected motion.

Failure to heed this warning can cause equipment damage, injury, or death.
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9.1.2 Latched vs Non-latched Faults Example

The drive’s temperature reaches the fault level. The drive reports the fault and disables the PWM output.
Then, the drive temperature falls below the fault level.

Non-latched fault operation:

The fault is cleared and the amplifier's PWM outputs are enabled without operator intervention.

Latched fault operation:

The fault remains active and the drive’s PWM outputs remain disabled until the faults are cleared as

described above.

9.1.3 Fault Latching Procedure

—_

Configure Faults . . .
: Click the Configure Faults button on the Main screen.

2. Select the faults to latch. See "Fault Descriptions " (= p. 37)

m Fault Configuration

Latched Faults
Shart Circuit
Amp Over Temperature
Motor Over Temperature
[] Over Voltage
[] Under Valtage
Feedback Error
[ Moter Phasing Error
Following Error

[] Command Input Lost

Optional Faults

[] owver Current (atched)

Restore Defaults

Cancel

*

Help

3. Click OKto close screen and save changes to amplifier RAM.

4. '“ On the Main screen, click Save to Flash to avoid losing the changes.
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9.2 Fault Descriptions

NOTE

The list of faults may vary with amplifier model.

Fault Fault Occurs When ... Fault is Corrected When ...
Description
*Short Cir- | Output to output, output to ground, internal PWM bridge | Short circuit has been removed.
cuit Detec- |[fault.
ted
*Amp Over | Amplifier's internal temperature exceeds specified tem- | Amplifier's internal temperature
Temperature | perature. falls below specified temperature.
Over Bus voltage exceeds specified voltage limit. Bus voltage returns to specified
Voltage voltage range.
Under Bus voltage falls below specified voltage limit. Bus voltage returns to specified
Voltage voltage range.
*Feedback | Over current condition detected on output of the internal | Encoder power returns to specified
error +5 Vdc supply used to power the feedback. voltage range.
Differential signals from incremental encoder not con- Feedback signals stay within spe-
nected. cified levels.
Differential signals connected.
Motor Phas- | Encoder-based phase angle does not agree with Hall Encoder-based phase angle
ing Error switch states. This fault can occur only with brushless | agrees with Hall switch states.
motors set up using sinusoidal commutation. It does not | See "Troubleshoot Manual Phase
occur with Halls correction turned off. w/ Encoder and Halls" (= p. 44)
*Following | User set following error threshold exceeded. See "Following Error Fault Details"
Error (=» p. 68)
*Motor Over | Motor over-temperature switch changes state to indicate | Temperature switch changes back
Temp an over-temperature condition. to normal operating state.
Over Cur- | Output current 12T limit has been exceeded. Amplifier is reset and re-enabled.
rent
(Latched)
*Latched by default.
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10 Motor Phasing

10.1 Auto Phase

The examples in this chapter show particular amplifier operating modes and motor feedback configurations.
Some screens and choices may vary from those described here.

10.1.1 Auto Phase Example: Servo Amplifier

NOTE

The following steps show Auto Phase with a brushless rotary motor, digital Halls, and an incremental quad-
rature encoder. Screens vary for other configurations.

1. Verify that the Enable Input is not activated and that HV or AC power is applied.

)
2. “_/Click Auto Phase to open the Auto Phase wizard.
ﬁAuto Phase x|

Motor Direction Setup

Move the motor in the direction that you want
to be positive. Press Next when done.

Motor Actual Position: 0 counts

Release Brake | Skip = | Cancel |

3. Move the motor in the direction to be considered positive.

OR

If you cannot move the motor, click Skip (you will confirm motor direction later).
4. Click Next to go to the Motor Wiring Setup step:

f_ Auto Phase x|
Motor Wiring Setup Commanded Motor Phase Angle
) ; 50
The software will now micro step the motor. 120 60
Make sure the motor is free to move. 150 ag
Press Start when ready and
observe the motor movement. 180 0
Auto Phase Current:l 0.53 A 210 230
240 200
270
Increment Rate: I 90 elec degfs
Motor Actual Position: 0 counts
Stop
Ready
< Back | Mext = | Cancel

5. Activate the Enable Input.
6. Click Start to begin the motor wiring setup.

The message area displays messages: Configuring Initial Settings, Microstepping, Test Complete,
Motor Wiring has been configured.

During microstepping, a current vector is applied to the motor windings and microstepped through an
electrical cycle at a set rate, causing the motor to move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for confirmation of correct
motor direction.

If the step fails see "Troubleshooting the Auto Phase Problems" (=¥ p. 41)
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NOTE

If incorrect values were entered for inductance and resistance, the calculated Cp and Ci values may
produce current loop oscillation, evidenced by an audible high frequency squeal during auto phasing.

7. Click Next to go to the Motor Wiring Setup step:

f_ Auto Phase x|
Motor Wiring Setup Commanded Motor Phase Angle
The software will now micro step the motor. 120 % 60
Make sure the motor is free to move. 150 ag
Press Start when ready and
observe the motor movement. 180 0
Auto Phase Current:l 0.53 A 210 230
240 200
270
Increment Rate: I 90 elecdegfs
Motor Actual Position: 0 counts
Stop
Ready
< Back | Mext = | Cancel |

8. Click Start to begin the Phase Count Test. Observe status messages. See the prompt:

x|

Observe motor motion and verify that it
moves 1 turn{s) before any gearing.

9. When you are ready to observe motion, click OK.

When motion is complete the prompt will be displayed:

Phase Counts k x|

Did motor move 1 turn{s)?
Mo |

« If motor did not turn 1 full turn, click No and see "Phase count test" (= p. 41).
« If motor turned 1 full turn, click Yes.
10. Click Next to open the Hall Wiring Setup screen.

x|

Hall Wiring Setup Commanded Motor Phase Angle
& Hall State

The software will now micro step the motor.

Make sure the motor is free to move. [ ] [ ]

Press Start when ready. 1290 &0

Auto Phase Current: I 132 A

Increment Rate: I 90 elec degfs . .
i | Hall States
u v W
Hall Offset: 0 deg . . .
Ready Lo Lo Hi

< Back | Iext = | Cancel |

11. Click Start to begin the Halls wiring setup. The message area displays the messages: Microstepping.
Test Complete. Motor has been properly phased.
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During microstepping, a current vector is applied to the motor windings and microstepped through an
electrical cycle at a set rate, causing the motor to move. As the motor moves the Hall lines are
decoded for proper commutation.

If the step fails, see "Halls wiring setup" (= p. 41).

12. If the Auto Phase algorithm does not produce desired results, try adjusting the Auto Phase Current and
Increment Rate values, using the guidelines in "Tips for Auto Phase Current and Increment Rate" (=
p. 40).

13. If desired results are not obtained, or to confirm results, proceed to "Manual Phase" (= p. 42)

14. Click Next to open the Position Feedback Wiring Setup screen.

x|
Position Feedback Wiring Setup
Make sure the load and motor are free to move. Press either Jog button to move.
Load Actual Position: 9 counts

Motor Velocity 217.42 rpm
Ready

Jog NEG |

< Back | FEinish | Cancel |

15. Click Start to begin the Position Feedback Wiring Setup.
16. Select either Jog Neg or Jog POS and ensure the motor rotates in the desired direction.

10.1.2 Tips for Auto Phase Current and Increment Rate

« If friction is high, more current may be required to move the load.

« High static friction may require more current to overcome stiction.

« Transition from static friction to dynamic friction, and back, may produce jerky motion.

« A fasterincrement rate will operate in the dynamic friction range.

« Aslower rate will operate in the static friction range.

« If thefriction is low, as in the case of air bearings, low frequency oscillations may occur; thus, less
current and slower rates may be required. If oscillations persist, then friction may need to be tem-
porarily added.
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10.2 Troubleshooting the Auto Phase Problems

10.2.1 Motor direction setup

If motor direction setup step failed:

« Check Encoder or resolver power and signals.
« Verify that the encoder is differential. (Contact factory if encoder is single-ended.)
« Check shielding for proper grounding.

10.2.2 Motor wiring setup

If motor wiring setup step failed:

Verify that amplifier is disabled.

Check for mechanical jamming.

Check for smooth motion with no mechanical jerking.

Check for good connections to the motor power wires.

Disconnect motor power wires and measure for proper motor resistance.

10.2.3 Phase count test

If phase count test failed:

Verify that in the Motor/Feedback screen the following parameters have been set correctly:

Number of Poles for rotary motors. Verify the motor’'s pole count with the "Data accuracy test" (= p.
44).

Magnetic Pole Pair Length for linear motors.

Encoder Lines or Fundamental Lines for rotary encoders.

Encoder Resolution for linear encoders.

10.2.4 Halls wiring setup

If Halls wiring setup step failed:

Check Halls power and signals.
Check for smooth motion with no mechanical jerking.
Check shielding for proper grounding.

If the auto phase procedure fails despite these corrective measures, see "Manual Phase" (= p. 42)

Kollmorgen | kdn.Kollmorgen.com | February 2019




RGM WorkBench User Guide | 10 Motor Phasing

10.3 Manual Phase

1. Remove load from the motor.
2. Onthe Main screen, choose Tools > Manual Phase to open the window:

Manual Phase x|
- Configuration ~Monitor
Halls————————————— Mo Faults
Invert Input: h‘;‘olzorlrgta?e Angle
Fu Ty TDw all State
Hall Wiring: |u vw v[ Hall States ————— [ | [ |
120 &0
Hall Offset: I 0 deg u V W
. . . M 150 \ o |
Motor Feedback Lo Hi Hi 240 300
’V ¥ Invert Input ] [

Motor Phase Angle:  300deg

Position Feedback
’V [ Invert Input Motor Feedback: -64465  counts
Motor Position Feedback: 66061 counts
v Invert Qutput
’V ~ i Actual Current:  U: ooza Ve -001A W 0.01A

~Control

Increment Rate: I 30 elec degfs Set Zero Position |

- 0.53
Current: o Move Maotor
" Enable {* Disable Rev | Ewd |
Regtore Defaults | OK | Cancel |

3. Verify the Current setting before enabling the drive.

¥ Enable Disable

4. To control the current vector rotation, command the motor forward or reverse.

Mawve Mator

5. If the motor cannot keep up with the rate of vector rotation, then reduce the Increment Rate orincrease
the Current.

6. Verify that pressing forward button moves motor forward. If the motor moves in the wrong direction,
toggle the Motor Invert Output setting.

7. Verify actual position count agrees with direction of rotation: increasing counts in forward direction and
decreasing counts in reverse direction. If it does not, toggle the Motor Feedback Invert Input box set-
ting.

8. Monitor the vector rotation through one electrical cycle for proper Hall transitions:

« Verify that the red indicator rotates in the same direction as the motor phase angle, and that the
transition occurs when the needle is between indicators (+30 degrees, as shown below).
Wotar Phaze ngle & Hall Siate

B an
1200 B0 e
[ RE ”
240 500
[ | [ |
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« If the needle and Hall states do not track properly, use the Hall Wiring list box and/or Invert

Invert Input:
Ou Ov Ow

Hall wiring: (LYW =]

Hall Offset: 0w v g

v UwW
rMotor Feedbagv W U

WV u
[ Inver
WU

« If the red indicator transition leads or lags behind the centered needle by more than 30 degrees,
then try adjusting the Hall Offset in +/- 30 degree increments:

Hall Offset: o deq

9. Phasing of a motor with encoder and Halls is complete. Click OK.
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10.4 Troubleshoot Manual Phase w/ Encoder and Halls

To perform trapezoidal commutation after power-up or reset, the amplifier must receive good Hall signals.
After the first Hall transition is detected, then sinusoidal commutation can be performed. In sinusoidal
commutation, the amplifier uses the encoder for commutation while monitoring the Halls to verify proper
phase. If the error between the encoder count and Hall transition is too large, then the Hall phase correction
will not be performed and a phase fault will be triggered.

Test for phase fault problems in the order shown below.

10.4.1 Data accuracy test

1. Verify the motor’s pole count:
« Apply a current vector at zero Increment Rate to lock motor in position.
« Tumn the motor shaft and count the number of distinct locking positions.
« Calculate the number of poles: Poles = number of locking positions * 2
2. Verify the encoder line count OR a linear motor's magnetic pair length and the encoder resolution.

10.4.2 Encoder wiring test

If the Halls produce good trapezoidal commutation but a phase fault is persistent in sinusoidal commutation
mode, the encoder is highly suspect:

Verify the differential encoder signals.

Verify proper twisted shielded cable with good grounding.

Disable the amplifier and move the motor manually to test for phase fault.

If phase fault only occurs under command of current, make sure the motor power cable is not bundled
with the encoder cable.

10.4.3 Hall signals test

If the Halls signals are suspected to be faulty:

« Make sure Halls change states as the motor moves through one electrical cycle.
« Some Hall signals are noisy and require filtering. Check with motor manufacturer.
« Some Halls are not properly calibrated to the motor manufacturer’s specification.

10.4.4 Hall transition test

If the location of the Hall transition is not within +/-30 degrees:

« Adjust Hall offset in smaller increments.
« Verify Hall alignment.
« Make sure motion is smooth.
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11 Control Loops

11.1 Current Loop Setup and Tuning

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be calculated with
"Calculate" (= p. 31).

| Loop .
Click I Loop to open the Current Loop screen:

m Current Loop

Commanded
Current

Peak Current Limit:
12T Time Limit:
Continuous Current Limit:

Current Loop Offset:

Current Ramp:

TN
———1
.\._ .-/
+

- X

}7

Current
Limiter

Input
Filters

M

Commanded
‘oltage

_.“II 'I:

T Actual Current

12.82 | A Cp: 400
1000 | ms i 50
527 |8 Drive
oA @
(O) Maximize Speed
0|mass

[] Enable Bus Clamping

Auto Tune Bandwidth

Close

Peak Current
Limit

Parameter Description

Used to limit the peak phase current to the motor. Max value depends upon the amplifier
model; Min value > continuous limit.

12T Time Limit

Sets 12T Time Limit in ms. See "Appendix: 12T Time Limit Algorithm" (= p. 119).

Continuous
Current Limit

Used to limit the Phase Current. Max Value is < Peak Current and depends upon the
amplifier model. Min value: 0

Current Loop
Offset

Sets current loop offset. Leave it set to zero until after tuning. For more information, see
"Offset" (= p. 50)

Cp Current loop proportional gain. Range 0 — 32,767.

Ci Current loop integral gain. Range 0 — 32,767.

Drive Output | Maximize Smoothness: Amplifier uses circular vector limiting to produce smooth operation
even into the voltage limits.
Maximize Speed: Allows for slightly more of the bus voltage to be used when in the voltage
limit. This may produce a small disturbance at top speed.

Enable Bus

Clamping

Auto Tune See "Current Loop Auto Tune" (= p. 48)

Bandwidth Measure bandwidth using the Cp and Ci values now in the amplifier.
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11.1.1 Manually tune the Current Loop

Apply square-wave excitation to the current loop and adjust current loop proportional gain (Cp) and current
loop integral gain (Ci) to obtain a desired waveform.

f_ Oscilloscope ol x|
File

Trace Status: Trace Canceled - Ready To Start Mew Trace
06

a5 el s frefiporeifip-hputil
0.4 {‘H
029
029
@ 0.1
%z 00
ERRE
-0.2
o] L\ L(\au
-0.4+
0.5 Ml'm“'“"'n A .\lvj..‘.‘,\"u'm Jepha i fa .
06 T

0.000 0.00z 0.004 0.006 0.002 0.010 001z 0014 0.016 o012 0.0z0 0.0zz 0.0z4 0.026
Time (zeconds)

Function Generator |3-':-"e | Settings I Gainsl Trajectory Limits | Position Paramsl Velodty Paramsl Measurementl

Ch 1| Commanded Current ITEEETEENE |
Apply To: ICurrent vl

Ch 2 | Actual Current ¥ AutoSetip

N I' T l Single Trace

Function: |Square Wave - ¢ch 3| pisabled [ sing

= bl [~ Auto Scale Lock
Amplitude: I 0.53 A Disable

Trace Time: IZS ms VI
, Ch 5 | Disabled

Frequency: 100 Hz

ch 6| pisabled Sample Rate: 62 ps

Start | Stop |

I'_j | Record {"Stop Trace
| |

NOTE

« During tuning, observe any warnings or faults that appear in the status bar of the scope.
o Some users prefer the Auto Tune feature. See Current Loop Auto Tune (p. 121)

Clear | Clo:

—_

Click the Scope Tool. E
2. Choose Current from the Function Generator Apply To: list

Apply To: ‘Current -

3. On the Settings tab, make sure Auto Setup is selected.
Auto Setup

Auto Setup automatically sets the following parameters:

Parameter Description

Function Generator Tab

Function Square Wave

Amplitude 10% of continuous current value
Frequency 100 Hz

Settings Tab

Channel 1 Commanded current (violet)
Channel 2 Actual current (blue)
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4. Verify that the Amplitude value is not excessive for the motor.

Amplitude: | 0.53 A

5. Click Start.

6. Onthe Gains tab, adjust current loop proportional gain (Cp):
~Current

Cp I 200 il
iz I 200 il

« Set current loop integral gain (Ci) to zero.

« Raise orlower Cp to obtain desired step response. (Typically, little or no overshoot with a 100

Hz, low-current square wave.) If the Cp value is too large, ringing may occur. If the Cp value is
too low, bandwidth decreases.

7. Adjust current loop integral gain (Ci) until desired settling time is obtained.
8. Press Stop to stop the function generator.

Stop

9. On the Main screen, click Save to Flash to avoid losing the changes.-_
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11.2 Current Loop Auto Tune

The current loop Auto Tune algorithm applies a square-wave command to the current loop and adjusts current
loop proportional gain (Cp) and current loop integral gain (Ci) until a desirable waveform is obtained.

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be calculated with
"Calculate" (= p. 31).

| Loo
1. I] Click | Loop to open the Current Loop screen:

2 Current Loop - *

Commanded

—
o Lo -,+-'/ ) Input Curent
'-.\ J Filters Limiter

=

Commanded

+ A, Voltage
_.“II 'I:

T Actual Current

Peak Current Limit: 12.82 | A Cp: 400
12T Time Limit: 1000 | ms i 50
Continuous Current Limit: 5.27 A
Current Loop Offset: oA

(O) Maximize Speed
Current Ramp: 0 | mAfS D Enable Bus Clamping

Auto Tune Bandwidth

Close

2. Verify that the amplifier is hardware enabled.

Auto Ti
3. Click Auto Tune to open screen and start the Current Loop Auto Tune.

f_ Auto Tune =IQI il
o .
Auto Tune Current: I 0.5 A
Status:  Auto Tune in progress.
Cp: 0 ci 0 _Iétc"rt Stop
[
by

4. To Change the Auto Tune Current, Press Stop, enter the new current in the Auto Tune Current field,
and then press Start.
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5. Observe the Auto Tune process and results. A typical example:
« Sets Cpand Cito zero and then adjusts Cp and Ci for optimal values.

L5

0.6

0.5 \_,_
0.4 lf e — —_————
|

03
j‘;o.z—
047
004/
0.1/
0.z
0.3
-0.4 T T T T T T T T T

0.0000 0.0005 0.0010 00015 0.0020 0.0025 0.00:320 0.0035  0.0040 0.0045 0.0050
Time (zeconds)

Auto Tune Current: I 0.5 A
Status:  Auto Tune in progress.

Cp: 763 Ci 0 St | s

« Uses afrequency sweep to determine the small signal, current loop bandwidth.

L5

1.00 T3

0.75
0.50 1
T 0.25 7
€ 0.00
3025
-0.50 1
-0.75

-1.00 — T L — —— T T
0.000 0005 0010 0015 0020 0025 0030 0035 0040 0045 0050 0055 0080 0.065
Time (zeconds)

Auto Tune Current: I 1A
Status:  Measuring Bandwidth

Cp: 717 Ci 131 El= |

« Displays the results: a set of Cp and Ci alternatives, and the bandwidth measured using the
high Cp and Ci values.

Auto Tune Results x|

== Auto Tune has determined new values for Cp and Ci along with
Iol high bandwidth measurement. Select desired settings.

Close |

CHigh g 717 g 131 Bandwidth: 3300 Hz
& Medium Cp: 430 i 73
= Low Cp: 287 i 52
C orginal cp: 400 G 50

¥ Save Cp and Ci to Flash
{~ Keep Cp and Ciin RAM only

Cancel |

6. Choose an action based on Auto Tune results.
« Choose which set of values to save: High, Medium, Low, or Original. The Medium values,
selected by default, are appropriate for most applications.
« Optionally choose how to save: Save Cp and Ci to Flash or Keep Cp and Ci in amplifier RAM
only.
7. Click OK to save the values as chosen, and close the Auto Tune Results window.
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11.3 Notes on the Current Mode and Current Loop

11.3.1 Current Loop Diagram

As shown below, the “front end” of the current loop is a limiting stage. The limiting stage accepts a current
command, applies limits, and passes a limited current command to the summing junction. The summing
junction takes the commanded current, subtracts the actual current (represented by the feedback signal), and
produces an error signal. This error signal is then processed using the integral and proportional gains to
produce a command. This command is then applied to the amplifier's power stage.

Current Loop

Current Integral Gain (Ci) H + | Command
.. P T :
Current Command— Current Limiter |Limited Current | ° Z Current Proportional Gain (Cp) |_:®>_,

Current Offset —| _/_\_ ryll

—

Limits: Feedback (Actual Current)
e Peak Current

e Continuous Current

e Peak Current Limit Time

11.3.2 Current Loop Inputs

« The amplifier's analog or PWM inputs.

« A CANopen network via the amplifier's CAN interface.
« A Kollmorgen Virtual Motion (CVM) control program.

« The amplifier's internal function generator.

In velocity or position modes, the current command is generated by the velocity loop.

11.3.3 Offset

The current loop offset is intended for use in applications where there is a constant force applied to, or
required of, the servomotor and the system must control this force. Typical applications would be a vertical
axis holding against gravity, or web tensioning. This offset value is summed with the current command before

the limiting stage.
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11.3.4 Limits
The current command is limited based on the following parameters:

Limiter Description

Peak Current Limit | Maximum current that can be generated by the amplifier for a short
duration of time. This value cannot exceed the peak current rating
of the amplifier.

Continuous Current | Maximum current that can be constantly generated by the amp-
Limit lifier.

2T Time Limit Maximum amount of time that the peak current can be applied to
the motor before it must be reduced to the continuous limit or gen-
erate a fault. For more details, see "Appendix: 12T Time Limit
Algorithm" (= p. 119).

NOTE

Although the current limits set by the user may exceed the amp-
lifier's internal limits, the amplifier operates using both sets of lim-
its in parallel, and therefore will not exceed its own internal limits
regardless of the values programmed.

Ramp Rate of change in current command. Used to limit jog moves ini-
tiated from the Control Panel Jog function in current mode, and in
advanced Indexer Program functions.

11.3.5 Current Loop Gains

Gain Description

Cp - Current The current error (the difference between the actual and the limited

loop commanded current) is multiplied by this value. The primary effect of this

proportional gain is to increase bandwidth (or decrease the step-response time) as the
gain is increased.

Ci - Current The integral of the current error is multiplied by this value. Integral gain

loop integral reduces the current error to zero over time. It controls the DC accuracy of

the loop, or the flatness of the top of a square wave signal. The error
integral is the accumulated sum of the current error value over time.

11.3.6 Current Loop Output

The output of the current loop is a command that sets the duty cycle of the PWM output stage of the ampilifier.
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11.4 Velocity Loop Setup and Tuning

Initial velocity loop proportional gain (Vp) and velocity loop integral gain (Vi) values can be calculated with
"Calculate" (= p. 31)

VL
E Click the V Loop button on the Main screen.:

2 Velocity Loop - *
Cammanded
Velaci Velocity & Accel. input |
Limiter Filter
+ (v d
- } Gains Output | Cument o
e % _,-'_-' Shift 4’( Filters

Actual Velocity

Vel. Limit:

Tracking
Windowe:

Time:

4500 | rpm Accel, Limit: 0 |rps? Vp: 32766
Decel. Limit: o |rps? iz 32766
Fast Stop Ramp: 750 | rps? Vi Drain: [u]
[[] Disable Gains
veff: o
145 | rpm

100 | ms

Close

Velocity
Limit

Parameter Description

Top speed limit. Max value may depend upon the back EMF & the Encoder value. Min value:
0.

Acceleration
Limit

Maximum acceleration rate. Max value may depend upon load, inertia, & peak current. Min
value: 1. (Does not apply in position mode.)

Deceleration
Limit

Maximum deceleration rate. Max value may depend upon load, inertia, & peak current. Min
value: 1. (Does not apply in position mode.)

Tracking See "Position and Velocity Tracking Windows" (=» p. 68)

Window

Tracking

Time

Vp Velocity loop proportional gain. Range: 0 to 32,767.

Vi Velocity loop integral gain. Range: 0 to 32,767.

Fast Stop Deceleration rate used by the velocity loop when the amplifier is hardware disabled. Range: 0
Ramp to 100,000,000. Default: velocity loop Decel. Limit value.

Low Gains |Increases the resolution of the units used to express Vp and Vi, providing more precise
Shift tuning. For more information, see "Velocity Gains Shift " (= p. 57)

Hi Gains Decreases the resolution of the units used to express Vp and Vi, providing more precise
Shift tuning. For more information, see "Velocity Gains Shift " (= p. 57)
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Parameter Description

ViDrain Vi drain modifies the effect of velocity loop integral gain. The higher the Vi Drain value, the

(integral faster the integral sum is lowered. Range: 0 to 32,000. Default: 0.

bleed)

Vcff Velocity loop command feed forward. The input command to the velocity loop (after limiting)
is scaled by this value and added to the output of the velocity loop.

11.4.1 Manually Tune the Velocity Loop

Apply square-wave excitation to velocity loop and adjust proportional gain (Vp) and integral gain (Vi) to obtain
desired waveform. For instance:

I

File
Trace Status: Trace Canceled - Ready To Start New Trace
280
200 2
150
100
EL 0
£ 0
5
& 50
2
-100
-160
-200
<250 T T T T T T T T T
0.00 0.0s 010 015 0.z0 025 0.30 0.35 0.40 0.45 0.60/
Time (zeconds)
Function Generator I Proﬁlel Settings Gains ITrajechory Limiisl Position Paramsl Velocity Paramsl Measurementl
- Position rVelocity Current
ep: | 1000 ﬂ vp: [ 260 ﬂ o [ o2 ﬂ
Apply To: I\n'elocity VI T T T
Function: ISquarEWEVE | AFF:I 0 ﬂ Vi | 200 ﬂ it | 166 ﬂ
Amplimge:l 200 rpm
Vff: I 16334 j
Frgquency:l 5 Hz
Start | !

gl Record Stop Trace | Clear | Close
| | |

NOTE

During tuning, observe any warnings that appear to the left of the trace.

1. Click the Scope Tool. I:-
2. Choose Velocity from the Function Generator Apply To: list.

Apply To: .'u'elm:ity -
3. On the Settings tab, make sure Auto Setup is selected.
Auto Setup

Auto Setup automatically sets the following parameters:

Parameter Description

Function Generator Tab

Function Square Wave

Amplitude |10% of maximum velocity value
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Parameter Description
Frequency |5Hz
Settings Tab

Channel 1 | Limited velocity (green).

Channel 2 | Actual Motor Velocity (white).
Verify that Amplitude value is not excessive for the motor.
Amplitude: 200 | rpm

Click Start.

On the Gains tab, adjust velocity loop proportional gain (Vp):
« Set velocity loop integral gain (Vi) to zero.
« Raise or lower proportional gain (Vp) to obtain desired step response. (Typically, little or no over-
shoot on a 5 Hz small, slow-speed square wave.)
. Adjust velocity loop integral gain (Vi) until desired settling time is obtained.
Press Stop to stop the function generator.

Stop

»

o

o

oo N

On the Main screen, click Save to Flash to avoid losing the changes. -"

©
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11.5 Notes on the Velocity Mode and Velocity Loop

11.5.1 Velocity Loop Diagram

As shown below, the velocity loop limiting stage accepts a velocity command, applies limits, and passes a
limited velocity command to the input filter. The filter then passes a velocity command to the summing
junction. The summing junction subtracts the actual velocity, represented by the feedback signal, and
produces an error signal. (The velocity loop feedback signal is always from the motor feedback device even
when an additional encoder is attached to the load.) The error signal is then processed using the integral and
proportional gains to produce a current command. Programmabile digital filters are provided on both the input
and output command signals.

Velocity Loop

Velocity Integral Gain (Vi
Velocity Limited — - I AN
PR y + .
Commang ™| Velocity Limiter >l gyge, | Velocity | - Z Velocity Proportional Gain (Vp) F:@——» Filter —Vg"entnd
Limits: |
e Velocity

e Acceleration* Feedback (Derived Velocity)

e Deceleration*
e Emergency Stop Deceleration*
*Not used w hen velocity loop is controlled by position loop. See "Velocity Loop Limits" for details.

11.5.2 Inputs

In velocity mode, the velocity command comes from one of the following:
« The amplifier's analog or PWM inputs.
« A CANopen network via the amplifier's CAN interface.

« A Kollmorgen Virtual Motion (CVM) control program.
« The amplifier's internal function generator.

In position mode, the velocity command is generated by the position loop.
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11.5.3 Velocity Loop Limits

The velocity command is limited based on the following set of parameters designed to protect the motor
and/or the mechanical system.

Limiter Description

Velocity Sets the maximum velocity command input to the velocity loop.

Limit

Acceleration | Limits the maximum acceleration rate of the commanded velocity input to the velocity loop.
Limit This limit is used in velocity mode only. In position mode, the trajectory generator handles

acceleration limiting.

Deceleration | Limits the maximum deceleration rate of the commanded velocity input to the velocity loop.
Limit This limit is used in velocity mode only. In position mode, the trajectory generator handles
deceleration limiting.

Fast Stop Specifies the deceleration rate used by the velocity loop when the amplifier is hardware dis-
Ramp abled. (Fast stop ramp is not used when amplifier is software disabled.) If the brake output is
active, the fast stop ramp is used to decelerate the motor before applying the brake.

NOTE

Fast Stop Ramp is used only in velocity mode. In position mode, the trajectory generator
handles controlled stopping of the motor. There is one exception: if a non-latched following
error occurs in position mode, then the ampilifier drops into velocity mode and the Fast Stop
Ramp is used.

11.5.4 Diagram: Effects of Limits on Velocity Command

The following diagram illustrates the effects of the velocity loop limits.

Limited Velocity

Commanded Velocity

D N _\
Vel Limit- — — 1‘ - \
! \
| '\
| I\
[ I\
| o\
| o ——
Accel Limit = = [==— Decel Limit —=—
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11.5.5 Velocity Loop Gains
The velocity loop uses these gains:

Gain Description

Vp- The velocity error (the difference between the actual and the limited commanded velocity) is
Velocity multiplied by this gain. The primary effect of this gain is to increase bandwidth (or decrease the
loop step-response time) as the gain is increased.

proportional

Vi - The integral of the velocity error is multiplied by this value. Integral gain reduces the velocity
Velocity error to zero over time. It controls the DC accuracy of the loop, or the flatness of the top of a
loop square wave signal. The error integral is the accumulated sum of the velocity error value over
integral time.

11.5.6 Velocity Gains Shift

The Velocity Gains Shift feature adjusts the resolution of the units used to express Vp and Vi, providing more
precise tuning. If the non-scaled value of Vp or Vi is 64 or less, the Low Gains Shift option is available to
increase the gains adjustment resolution. (Such low values are likely to be called for when tuning a linear
motor with an encoder resolution finer than a micrometer.) If the non-scaled value of Vp or Viis 24001 or
higher, the High Gains Shift option is available to decrease the gains adjustment resolution.

11.5.7 Velocity Loop Filters
"Standard Filter Types" (= p. 97)

11.5.8 Velocity Loop Outputs
The output of the velocity loop is a current command used as the input to the current loop.

11.5.9 Proper Tracking Over Time

As described earlier, position error is the difference between the limited position output of the trajectory
generator and the actual position. Velocity error is the difference between commanded and actual velocity.

When the position or velocity error exceeds the programmed tracking window value, a status word bit is set.
The bit is not reset until the error remains within the tracking window for the programmed tracking time.

11.5.10 Velocity Tracking lllustration
The following diagram illustrates the use of tracking window and time settings in velocity mode.
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Actual Velocity

Limited Velocity

* Tracking Window
/
/
| Trackin
g
Y, / =~ Time= —
| |
/
/ | |
! |
Tracking Window
Output
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11.6 Position Loop Setup and Tuning

Initial position loop proportional gain (Pp), velocity feed forward (Vff), and acceleration feed forward (Aff)
values can be calculated with "Calculate" (= p. 31)

P Loop . .
1. l Click the P Loop button on the Main screen.

2 Position Loop - *

Trajectory Values Position Loop Values

Profile Acceleration
| AR

Profile Veloc ,—|
= LR
+][ Commanded
T, y i
I'. ._: G \Velocity
AN ___/-' Multipier
Limited Position
Actual Position
Pp: 1000 Pi: 1] Aff: 1] Gains Multiplier: 3.18
Pi Drain: 0 Vff: 16384
100% Vff = 16384
Pd: 0
[] Enable PID
Following Error Tracking
Fault: 16520 | counts Windowe: 4130 | counts
Warning: 8260 | counts Time: 10 | ms
[[] Disable Fault

Close

Parameter Description

Aff Acceleration feed forward. Range: 0 to 32,767. See "Trajectory Limits " (< p. 66)
VFf Velocity feed forward. Range: 0to 32,767. 100% Vff: 16,384.
"Trajectory Limits " (=» p. 66)
Pp Position loop proportional gain. Range: 0 to 32,767. See "Trajectory Limits " (= p.
66)

Gains Multiplier | Position loop output is multiplied by this value before going to the velocity loop. In
dual encoder systems, the multiplier’s initial value is calculated based on the ratio
of motor encoder turns to position encoder turns.

Following Error | The level (in encoder counts) at which the following error produces a fault, which
Fault stops the servo loop. We recommend raising the fault level before tuning the loop.
See "Following Error Faults " (= p. 67)

Following Error | The level (in counts) at which the following error produces a warning (without stop-
Warning ping the loop). See "Following Error Warnings" (= p. 67)
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Parameter  Descripon

Disable Fault | Stops following error from faulting. See "Following Error Faults " (< p. 67)

Tracking Win- | Width of tracking window in counts. See "Position and Velocity Tracking Win-
dow dows" (= p. 68)

Tracking Time | Position must remain in the tracking window for this amount of time to be con-
sidered tracking. See "Position and Velocity Tracking Windows" (=» p. 68)

Pi Position loop integral gain
Pd Position loop derivative gain
Pi Drain Position loop integral drain

Enable PID Enables the PID parameters
2. Click the Position Wrap button.

Position Wrap >

Motor Position Wrap: D| counts

1 revolution of the motor is 17944 counts.

Load Position Wrap: 0 | counts
1 revolution of the load is 524288 counts.

Ok Cancel Help

3. Change/verify the position wrap parameters as needed. Set both values to zero to disable position
wrapping. Note that the changes do not take effect until OK is pressed.
For more information about this feature, see "Position Wrap" (= p. 67)

Parameter Description

Motor Position | Position at which the actual motor position count retumns to zero.
Wrap In a single feedback system, it also applies to the actual load
position.

Load Position | Position at which the actual load position count returns to zero in
Wrap dual feedback systems. If the position encoder is set to passive
mode, this value applies to the passive encoder position.
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4. Click on the Trajectory Values tab:

2 Position Loop - *
Trajectory Values  position Loop Values
Profile Velocity
| i
Commanded Position tocity & A Profile Acceleration &
Limiter 5l
Limited Position
| -
>
Max Velocity: 35 | rpm Max Accel.: 2 rps?
Max Decel.: 2 rps?
Clear Limits
Abort Decel.: 2 rps?
Jerk: 0 |rps?
Abort Jerk: rps?
I ——— —— e —

Parameter Description

Max Velocity

Maximum trajectory velocity. Max value may depend upon the back EMF and the
Max feedback count. Min:0. Default: 0.25 x motor velocity limit.

Max Accel

Maximum trajectory acceleration. Max value may depend upon the load inertia and
peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit value.

Max Decel

Maximum trajectory deceleration. Max value may depend upon the load inertia and
peak current. Min:0 (disables limit). Default: 0.5 x velocity loop Accel. Limit value.

Abort Decel

Deceleration rate used by the trajectory generator when motion is aborted. Min:0.
Default: 0.5 x velocity loop Accel. Limit value.

Jerk

Rate of change of acceleration. The value of jerk set during the calculate procedure
produces an S-Curve whose maximum slope is equal to the trajectory profile slope.
This value will produce a maximum acceleration that is not more than the initial
default value of acceleration. Small values will produce less jerking but will take
longer to complete move. Large values will produce more jerking and a more
trapezoidal profile but will complete the move faster.

NOTE

Setting limits to zero disables the trajectory generator so that the command input is not limited by the
generator. Velocity is only limited by the Velocity Limit set in the Velocity Loop.
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11.6.1 Manually Tune the Position Loop

Minimize following error and oscillation by running profiles and adjusting position proportional gain (Pp),
velocity feed forward (Vff), acceleration feed forward (Aff) and other settings. For instance:

f_ Oscilloscope

File
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=lofx

Trace Status: Trace Canceled - Ready To Start New Trace
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(=unoa) 1oug Bumogo 4

Time (seconds)
NOTE

During tuning, observe any warnings that appear to the left of the trace.

1. Click the Scope Tool. I:-
2. Select the Profile tab.

Function Generator F[:§ﬁ|e I

| I o

3. Onthe Settings tab, make sure Auto Setup is selected. Auto Setup automatically sets the following

parameters Y| Auto SEtUp
Parameter Description
Profile Tab
Move Relative
Type Trap
Distance 150000 counts

Reverse and repeat

Not selected

Settings Tab
Channel 1 Profile velocity (Violet)
Channel 2 Following error (Blue)

4. |If the Auto Setup default profile distance is not appropriate, enter an appropriate short distance.

Distance: I IZIEDDUU counts

5. Click Start. The Profile Generator executes a short move.

NOTE

« The profile may not reach constant velocity during a short move.
« If afollowing error occurs, open the Control Panel and click Clear Faults.
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6. Set up atrapezoidal profile by setting the trajectory limits and distance. See table below.

Function Generator Profile

Setﬁngsl Gains Trajectory Limits | Position Paramsl Velodty Paramsl Measurementl

Mave: Type:
Lo R TE R [ 35 mem i+ Relative % Trap
Maximum Acceleration: I—ZD rps i At_:sﬁte {5 Curve
Maximum Deceleration: I—ZD rps?
T —_—E Distance: | 150000  counts

and

Parameter  Description

Trajectory Limits Tab

Maximum Set values typical of those expected to be used in the application.

Velocity

Maximum

Acceleration

Maximum

Deceleration

Profile Tab

Distance Set the move distance to produce a complete trajectory profile. Be sure that this dis-
tance does not exceed mechanical limits of the system.

Move Relative

Type Trap

7. Adjust position proportional gain (Pp) to minimize following error:
« Onthe Gains tab, set velocity feed forward (Vff) and acceleration feed forward (Aff) to zero.
« On the Profile tab, click Start. On the Gains tab, adjust position loop proportional gain (Pp) until
best result is obtained.
« Click Start after each adjustment to test on a new profile move.

~ Position
Pp: 1000 —
AfF: 0 =
VT 16384 ~—

NOTE

« Too much position loop proportional gain (Pp) might cause oscillation.
« If afollowing error occurs, open the Control Panel and click Clear Faults.

8. Adjust velocity feed forward (Vff):
« Velocity feed forward (Vff) reduces following error in the constant velocity portion of the profile.
Often, a velocity feed forward (Vff) value of 16384 (100%) provides best results.
o Click in the Vff field and adjust the value.
« Click Start after each adjustment to test on a new profile move.
9. Adjust acceleration feed forward (Aff):
« Acceleration feed forward (Aff) reduces following error during profile acceleration and decel-
eration.
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« Click in the Aff field and adjust the value.
« Click Start after each adjustment to test on a new profile move.

NOTE

« If, after tuning the position loop, the motor makes a low frequency audible noise while enabled
but not moving, the velocity loop gains (Vp and Vi) may be lowered to reduce the noise. If the
gain values are set too low, the response to instantaneous rates of change might be reduced
(i.e., slow correction to disturbances or transients).

« If the amplifier is set up to run in position mode under analog input command, and the analog
command signal produces too much noise at the motor after tuning, the Analog Command Fil-
ter or the Velocity Loop Command Filter may be used to reduce the noise further.

10. Tune to multiple sets of profiles representing typical moves that might be executed in the application.
Starting with Step 6, repeat the process as needed.
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11.6.2 Test S-Curve Profile

If the amplifier will perform S-Curve profile moves, use this procedure to tune the level of jerk. (Jerk is the rate
of change of acceleration. S-Curve moves reduce jerk to provide a smooth profile.) Run an S-Curve profile
and adjust velocity, acceleration, deceleration, and jerk levels until the desired profile is obtained. For
instance:

laix
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1. Onthe Profile tab, click the S-Curve button.

or | Profie

2. Setupan S Curve profile by adjusting the following parameters to represent a typical move under nor-
mal operation.

Parameter Description

Trajectory Limits Tab

Maximum Maximum speed of the profile.
Velocity

Maximum Maximum acceleration/deceleration of the profile. The deceleration is set to be the
Acceleration/ | same as acceleration.
Deceleration

Maximum The value of jerk set during the calculate procedure produces an S-Curve whose max-
Jerk imum slope is equal to the trajectory profile slope. This value will produce a maximum
acceleration that is not more than the initial default value of acceleration. Small values
will produce less jerking but will take longer to complete move. Large values will pro-
duce more jerking and a more trapezoidal profile but will complete the move faster.

Profile Tab
Distance Increase the move distance to produce a complete trajectory profile. Use an accept-
able value the does not exceed mechanical limits of the system.
Move Relative
Type S-Curve
3. Click Start

4. Try multiple sets of profiles representing typical moves that might be executed in the application. Start-
ing with Step 2, repeat the process as needed.
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11.7 Notes on the Position Mode and Position Loop

11.7.1 Position Loop Diagram

The amplifier receives position commands from the digital or analog command inputs, over the CAN interface
or serial bus, or from the CVM Control Program. When using digital or analog inputs, the amplifier's internal
trajectory generator calculates a trapezoidal motion profile based on trajectory limit parameters. When using
the CAN bus, serial bus, or CVM Control Program, a trapezoidal or S-curve profile can be programmed. The
trajectory generator updates the calculated profile in real time as position commands are received.

The output of the generator is an instantaneous position command (limited position). In addition, values for the
instantaneous profile velocity and acceleration are generated. These signals, along with the actual position
feedback, are processed by the position loop to generate a velocity command.

To bypass the trajectory generator while in digital or analog position modes, set the maximum acceleration to
zero. The only limits in effect will now be the velocity loop velocity limit and the current limits. (Note that
leaving the maximum acceleration set to zero will prevent other position modes from operating correctly.)

The following diagram summarizes the position loop.

Profile Velocity N : Position Loop
> Velocity Feed Forw ard (Vff)
:;?t?;n ;:E::::z Profils Acceleration ,I Acceleration Feed Forw ard (Aff) MUGR?};:GI' —> \(;:rlfr(::{\d
,—» _/_\_ Limited Position s \Z [ Position Proportional Gain (Pp) |
Limits: T
: ﬁ’; :if:lity Feedback_o/o<7 from motor encoder or resolver
: X?)ﬁr?iiilel Od--------ccmmoann from optional position encoder (on load)

11.7.2 Trajectory Limits
In position mode, the trajectory generator applies these limits to generate the profile.

Limiter Description

Maximum Velocity Limits the maximum speed of the profile.

Maximum Limits the maximum acceleration rate of the profile.
Acceleration
Maximum Limits the maximum deceleration rate of the profile.

Deceleration

Abort Deceleration Specifies the deceleration rate used by the trajectory generator when motion is
aborted.

11.7.3 Position Loop Inputs From the Trajectory Generator

The position loop receives the following inputs from the trajectory generator.

Input Description

Profile The instantaneous velocity value of the profile. Used to calculate the velocity feed forward
Velocity value.

Profile The instantaneous acceleration/deceleration value of the profile. Used to calculate the
Acceleration | acceleration feed forward value.

Limited The instantaneous commanded position of the profile. Used with the actual position
Position feedback to generate a position error.
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11.7.4 Position Loop Gains
The following gains are used by the position loop to calculate the velocity command:

Gain Description

Pp - The loop calculates the position error as the difference between the actual and limited position
Position values. This error in turn is multiplied by the proportional gain value. The primary effect of this

loop gain is to reduce the following error.

proportional

VFf - The value of the profile velocity is multiplied by this value. The primary effect of this gain is to

Velocity decrease following error during constant velocity.

feed forward

Aff - The value of the profile acceleration is multiplied by this value. The primary effect of this gain
Acceleration | is to decrease following error during acceleration and deceleration.
feed forward

Gain The output of the position loop is multiplied by this value before being passed to the velocity
Multiplier loop.

11.7.5 Position Loop Feedback
Some Kollmorgen amplifiers feature dual-sensor position loop feedback, configured as follows:

« Single sensor. Position loop feedback comes from the encoder or resolver on the motor.
« Dual sensor. Position loop feedback comes from the encoder attached to the load.

NOTE

In either case, velocity loop feedback comes from the motor encoder or resolver.

11.7.6 Position Loop Output
The output of the position loop is a velocity command used as the input to the velocity loop.

11.7.7 Position Wrap

The position wrap feature causes the position reported by the amplifier to “wrap” back to zero at a user-
defined value instead of continually increasing. Once set, the reported position will be between 0 and n-1
where n is the user entered wrap value. This feature is most useful for rotary loads that continually turn in one
direction and only the position within a revolution is of interest to the user.

Relative moves with the wrap value set will move the relative distance called for. Example; if the wrap value
is set to 1000 and a relative move of 2500 is commanded, the axis will turn 2 % revolutions.

Absolute moves will move the shortest distance to arrive at the programmed position. This could be in the
positive or negative direction. Moves programmed to a point greater then the wrap value will cause an error.

11.7.8 Following Error Faults

When the position error reaches the programmed fault threshold, the amplifierimmediately faults. (The
following error fault can be disabled.)

11.7.9 Following Error Warnings

When the position error reaches the programmed warning threshold, the amplifierimmediately sets the
following error warning bit in the status word. This bit can be read over the CAN network. It can also be used
to activate a digital output.
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11.7.10 Position and Velocity Tracking Windows

When the position error exceeds the programmed tracking window value, a status word bit is set. The bit is
not reset until the position error remains within the tracking window for the programmed tracking time.

A similar method is used to handle velocity errors.

11.7.11 Following Error Fault Details

11.7.11.1 Position Error Reaches Fault Level

As described earlier, position error is the difference between the limited position output of the trajectory
generator and the actual position. When position error reaches the programmed Following Error Fault level,
the amplifier faults (unless the following error fault is disabled.) As with a warning, a status bit is set. In
addition, the fault is recorded in the error log. See "Error Log" (= p. 112).

Additional responses and considerations depend on whether the fault is non-latched or latched, as described
below.

11.7.11.2 Amplifier Response to Non-Latched Following Error Fault

When a non-latched following error fault occurs, the amplifier drops into velocity mode and applies the Fast
Stop Ramp deceleration rate to bring the motor to a halt. The amplifier PWM output stage remains enabled,
and the amplifier holds the velocity at zero, using the velocity loop.

11.7.11.3 Resuming Operations After a Non-Latched Following Error Fault

The clearing of a non-latched following error depends on the amplifier's mode of operation. Issuing a new
trajectory command over the CAN bus or the ASCII interface will clear the fault and return the amplifier to
normal operating condition.

If the amplifier is receiving position commands from the digital or differential inputs, then the amplifier must be
disabled and then re-enabled using the amplifier's enable input or though software commands. After re-
enabling, the amplifier will operate normally.

11.7.11.4 Amplifier Response to a Latched Following Error Fault

When a latched following error fault occurs, the amplifier disables the output PWM stage without first
attempting to apply a deceleration rate.

11.7.11.5 Resuming Operations After a Latched Following Error Fault

A latched following error fault can be cleared using the steps used to clear other latched faults:

« Power-cycle the amplifier
« Cycle (disable and then enable) an enable input that is configured as
Enable with Clear Faults or Enable with Reset
« Access the RGM WorkBench Control Panel and press Clear Faults or Reset
o Clearthe fault over the CANopen network or serial bus
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12 Homing

12.1 Homing Overview

The Homing screen allows homing to be configured and tested. Changes made to this screen get saved to
amplifier RAM. On amplifiers configured for Absolute encoders, calibration can be performed.

Click the Home button on the Main screen to open the Home screen

Home *
Software Limits
Positive: 0 | counts Deceleration Rate: 0| rps?
Megative: 0 | counts
Disable
Method: | Set Current Position as Home w
Direction of Motion
Positive Megative Offset: 524233 | counts
Current Threshold: ofa
Fast Velodity: 5| rpm Current Delay Time: 0| ms
Slow Velodty: 1| rpm Following Warning: 8260 counts
AccelDecel: 2 rpst? Actual Current: A
Actual Position: counts
[] Test without home adjustments Homing Adjustment: counts
Home Stop Calibrate Exit

Parameter Description

Software limits: Positive | Position of user-defined travel limits that take effect after homing operation.

Software limits: Negative

Software limits: Deceleration rate used to stop a motor when approaching a software limit.

Deceleration Rate

Software limits: Disable | Disables the use of software limits by setting both limits to zero.

Method

Homing method. See "Homing Method Descriptions" (= p. 122)

Direction of Motion

Initial direction of motion for the homing method (Pos or Neg).

Fast Velocity The velocity used to find a limit or home switch. Also used when moving to an
offset position, or aresolver or Servo Tube index position.

Slow Velocity The velocity used to find a switch edge, incremental or analog encoder index
pulse, or hard stop.

Accel/Decel The acceleration and deceleration rate used during homing.

Offset Execute a move of this distance after the reference is found. Set actual position

to 0 and call the new position home.

Current Limit

Current Delay Time

Hard stop home is reached when the amplifier outputs the homing Current Limit
continuously for the time specified in the Delay Time.

Following Warning

Shows the programmed following warning level.

Actual Current

Shows actual current being applied to windings during homing.

Actual Position

Shows the actual position of the axis.
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Parameter Descripton

Homing Adjustment Shows the Home offset measured after homing is performed.
Test without home Selecting this option and pressing the Home Button tests the adjusted home
adjustments position without making any changes to the saved home position. The resulting

homing offset is reported in the Homing Adjustment text field.

— Starts the homing sequence using the settings shown on the screen.

= Stops the homing sequence.

Saye Saves the homing parameters to amplifier flash.

L
=]

Exik Discards unsaved homing parameters, then closes the screen. The rules for
discarding unsaved values are as follows:

« If the Save button was never clicked, all of the homing parameters will
be reverted to the values at the time that the screen was opened..

« Ifthe Save button was clicked, then the homing parameters will be rever-
ted back to the values at the time of the last Save event.

Upon closing, any home sequence in progress will be aborted.

12.2 Mechanical Homing

Mechanical homing is the process of moving the motor to the position that is machine-zero. This is the
location from which all dimensions are absolute in the machine’s position reference frame.

Enter the values of the appropriate homing parameters.
. Click the Home button to run the home sequence.

Home

Repeat if necessary until the motor is positioned at machine zero.
Click the Save button.

Save

12.3 Zeroing the Home Position Example

N =

Bw

Following is a recommended procedure for setting the Home position to zero (0).

1. Clear the Mutli-turn Encoder information.

| @ RGM Workbench V&0 Beta 7 (801-1395 unname o - I
File Amplifier Tools Help

BOCOEM« B S mMH

= | Kollmergen Neighbarhoc

CAN Network:  Address: 1 State: Pre-operational

2 ASCI Command Line — x

Command: |ldenc zero|

Response: |0k

&

< >

Close
@ Axis A E..

Axis B

Agis C || G fig:e Filters
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From the main RGM WorkBench screen, select the Home button.

File Amplfier Tools Help K
BOORM . [ I=wH
=

Kellmargen Neighberhood

BB Virtual Amplifier

BB CANT: RGM14
=B CAND RGWI1T

=lalx]

CANNetwork:  Address: 3

=B CaNe: RGM25

CVM Control Frogram

Frogrammed Position I—; P Loop I—; V Loop |—; I Loop I—; Motor |

L =—

@ Axis A [ e Configure Faults
© AxisB N—
0 Axis C Configure Filters
€ AxisD
|amp Enabled

3. Select Set Current Position as Home from the Method drop-down menu. Then save and exit the
window.

Software Limits
Positive: 0 counts
Negative: 0 counts

x|

Deceleration Rate: 0 rps?

Discbie |

Method: [Set Current Positian as Home

]

Direction of Motion

(% Positive {7 Negative Offset: 828854 counts
CurrentThreshold: 0.2 A

Fast Velodity: 15 rpm

Currenl%ela‘.‘ Time: 250 'ms

Slow Velodity: 1 rpm
Accel/Decel: 3 rps®

Fallowing Warning:

Actual Current:

Actual Position:

[~ Test without home adjustments

Home I

Homing Adjustment:

sop | | cebate |

828855 counts

Save Exit

8250 counts

A

1 counts

4. Open the Control Panel @ and confirm that the Home LED icon is yellow and that the status is Not

Referenced (shown below).

% Control Panel

5. From the Monitor section, choose the Active Load Position setting, then close the window.

=01l

rStatu: rMonitor
- — (Jactve Loaa Position ~ I._ counts
8 © Motor Output: Active
- € Hardware Enabled:  Enabled Actual Load Velocity ~ | IR o
!"- © Software Enabled:  Enabled
- © Positive Limit: Not Active Active Load Position - _ counts
© Negative Limit: Nat Active
7 © Software Limits: Not Active Mode: P F 5
e ok lode: Position, Programme
© Motion Abort Input: ot Active
[ RunRing Move
T Home: Nat Referenced Velocity 1 rpm
tatus: oK — l— )
 Gain Scheduling: Mot Active #reslernion Lo
Deceleration 0.42 rps?
& I= Enable Jog Move NEG | Move FOS |
Enable | Set Zero Position |
Dissbe | Clear Faits | Reset
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6. Click the Home button.

File Amplfier Tools Help K
SOOEM . O] -
=

Kellmargen Neighberhood

BB Virtual Amplifier

BB CANT: RGM14
=B CAND RGWI1T

=lalx]

CANNetwork:  Address: 3

=B CaNe: RGM25

CVM Control Frogram

Frogrammed Position I—; P Loop I—; V Loop |—; I Loop I—; Motor |

L =—

@ Axis A | Home: Configure Faults
© AxisB N—
0 Axis C Configure Filters
0 AxisD
|amp Enabled

7. From the Method drop-down menu select Absolute Encoder Immediate Home.

Note the Actual Position counts. If the desired home position count is "0", then enter the negative
value of the Actual position in to the Offset field.

Home x|

~Software Limits

Positive: I 0 counts Deceleration F‘.ate:l 0 rps?

Negati'ue:l 0 coumts

Disable |

L o e
=l | Absolute Encoder Immediate Home
Direction of Motion

* | Positive ) Megative Offset: | -328854 counts

Current Threshold: I [ =

FastVelodty: I 15 rpm Current Delzy T 250 ms

Slow Velodtys I 1 (rpm

Following Warnfia:

ool counts

AccelDecel; I 3 | rps2 Actual Currents A
Actual Position: 828851 counts
[T |Test without home adjustments Homing Adjustment: 1 counts
Home Stop Calibrate Save | Exit |

Save and Exit the window.
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8. Open the Control Panel and select Reset. Note that the Active Load Position is set to 0.

‘Control Panel 0 ll
[ Statu: Manitor
5T0: Active Load Position - | R o
© Motor Output: Active

© Hardware Enabled:  Enbled Actual Load Velocity - | I o

© Software Enabled: Enabled

L ErElTE Not Active Active Load Position - | R oo
© Negative Limit: Not Active

€ Software Limits: Mot Active # Control Panel —|3Ix]
© Motor Phase: oK
€ Motion Abort Input:  Not Active [ Statu [ Manitor
© CVM Control Program:  Running . Active Load Position - | g -
 Home: Not Referenced © Motor Cutput: Active
© Network Status: oK € Hardware Enabled:  Enabled Actual Load Velodity ~ | I o
( Gain Scheduiing: Not Active © Software Enabled:  Enabled
© Positive Limit: Not Active Active Load Position - _ counts
© Negative Limit: Not Active
© Software Limits: Not Active . .
Control © Motor Phase: oK lode: Fosition, Programme:
© Motion AbortInput:  Hot Active
. rMave
Enable | Set zera Position | € CyM Control Program: - Running -
€ Home: Referenced Velocity 1 rpm
Dsabe | Cearfaits | Reset | © Metwork Status: oK S —
( Gain Scheduling: Not Active AeEeration S R
Deceleration 0.42 psz
Contrel I~ Enzble Jog Move NEG | Moye POS |
Erabe | Set Zeroposition |

Disable | Clar Fauits | Reset | Close
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13 Control Panel

13.1 Control Panel Overview

. Click to open the Control Panel.

Status Indicators

Monitor real-time amplifier values

Status Indicators And operational mode
ﬁ(onlml Panel { _J- _.ID !'
Status k Monitor .
RED if fault o 570 Actual Current - _ A
_
is active a € Motor Output: Active
- © Hardware Enabled:  Enabled Gear Temperature ~ | e
Yellow if fault € Software Enabled:  Enabled
s active A © posmetint:  Notacve e
€ Negative Limit: Not Active
i —_ € Ssoftware Limits: Not Active
Display error log - © Motor Phase: oK Mode: Position, Programmed

 Motion Abort Input: Mot Active

(_ CVM Control Program: Not Running Move
© Home: Referenced Velocity, 1.75 rpm
@ Network Status: Error
e Al
(' Gain Scheduling: Not Active Acceleration 4 rps
Deceleration 4 rps?
M ge box
: [~ Enable Jog Move NEG | Move POS |
SetZeraPosiion | k
Control functions
Disable Clear Faults | Reset e

Jog mode controls
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13.2 Status Indicators and Messages

The Status area includes status indicator lights (described below) and a message box. Any red lights indicate
that motion will be inhibited.

Indicator  States/Descripion

Safety State of the safety circuit. Enabled or HI/LO disabled. On amplifiers with safety circuit.

Motor Output | State of the PWM output stage. Red if the output stage is inactive (disabled)

Hardware State of the hardware enable input(s). Red if one or more enable inputs are inactive.

Enabled

Software State of the software enable. Red if the amplifier is disabled by software.

Enabled

Positive Limit | State of the positive limit switch input. Red indicates an activated positive limit switch.

Negative State of the negative limit switch input. Red indicates an activated negative limit switch.

Limit

Software State of the software limits. Red indicates an activated software limit.

Limits

Motor Phase |Indicates a motor phasing error. Red indicates a motor phasing error exists.

Motion Abort | State of the programmed Motion Abort Input. Red indicates the input is active.

Input

CVM Control |Status of the CVM Control Program.

Program

Home Indicates whether the axis has successfully been referenced (homed).

CAN Status | Status of the CAN Bus. Yellow indicates CAN warning limit reached. Red indicates bus
error detected.

Gain Indicates whether "Gains Scheduling" (=» p. 115) is active.

Scheduling

s Indicates that a fault is active. Check the status message box for a description of the most
recent fault: Fault: Under Yoltage .
Check the Error Log for a full history of faults and warnings.
' Indicates that a warning is active. Check the status message box for a description of the

_-.____I_\ most recent: "arming: Pos Dukside of Tracking \Wwindow .
Check the Error Log for a full history of faults and warnings.

Message Box | Displays status descriptions.
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13.3 Control Panel Monitor

The Control Panel Monitor displays real-time values of selected variables.

~Maonitor

ICl:ummanl:IEd Velocity

~ | I o

I.ﬁ.ctl_lal Motor Velocity

~ | I o

I.-!'.ctl_l.al Motaor Position

MQ&: Position, Programmed

=] I -

Monitor Variables

Actual Current

Following Error

Passive Load Position

Actual Motor Velocity

Commanded Current

Limited Position

Actual Motor Position

Commanded Velocity

Analog Command

Actual Load Velocity

Commanded Position

Bus Voltage

Actual Load Position

Profile Velocity

Amplifier Temperature

Velocity Error

Profile Acceleration

Motor Phase Angle

Mode: Displays the amplifier's operating mode in RAM. In camming mode it also displays the active cam

table number
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13.4 Control Functions

The Control area of the screen provides functions related to overall amplifier control. The screen options vary
with model and configuration.

Control ~ Descripton

Enable Click to software enable the amplifier.
Disable Click to software disable the amplifier. This will also stop any CVM programs that are
running.

Set Zero Click to set the amplifier's actual position counter to zero.

Position

Clear Faults Click to clear all amplifier faults.

Reset Click to reset the amplifier.

A Risk of unexpected or uncontrolled motion.

WARNING Using the RGM WorkBench Set Zero Position function while the amplifier is operating under
external control could cause unexpected or uncontrolled motion.
Failure to heed this warning can cause equipment damage.
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13.5 Jog Mode

Jog mode provides a simple means for moving/jogging the motor.

rMove

Move

Velodty I 1.75 rpm
Acceleration I 4 rps?
Deceleration I 4 rps2

MNEG | Move POS |

1. To put the amplifier in jog mode, select Enable Jog.
2. Set up ajog move by setting the following mode-specific parameters:

Mode | Parameter Description
Current | Current Current applied to the motor. Limited by current loop Continuous Current.
Warning: Unloaded motors may, depending on torque setting, ramp up in
speed very quickly.
Velocity | Jog Speed | Velocity of the jog move. Limited by velocity loop Vel. Limit.
Position | Velocity Velocity of the jog move. Limited by velocity loop Vel. Limit.
Acceleration | Acceleration limit of the jog move.
Deceleration | Deceleration limit of the jog move.

3. Command the move:

Current

Mode | Steps

« Hold Pos to apply positive current to the motor or hold down Neg to apply negative
current to the motor.
« Release the button to command zero current.

Velocity

» Hold Jog Pos to command a forward velocity or hold down Jog Neg to command a
negative velocity.
» Release the button to command zero velocity.

Position

« Hold Move Pos to generate a forward move profile or hold Move Neg to generate a
negative move profile.
« Release the button to stop movement.

NOTE

Position mode jog is accomplished by continuously updating the commanded position. If a
following error develops with Following Error Fault disabled, motion will not stop on button
release. Instead, it stops when actual position = commanded position.
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14 Oscilloscope

14.1 Oscilloscope Overview

The Oscilloscope can be used to tune the amplifier, monitor performance, and perform diagnostics. Function

Generator and Profile Generator can drive the motor without external control. Auto Set Up feature sets typical
initial values for scope parameters.

f_ Oscilloscope = IEI Iil
File
Trace Status: Trace Canceled - Ready To Start New Trace
20 35 200 0
15 204 150 g
0 254 o0 26
I g
2 5§20 Fso 24 o
T & E-
5 z - m. =
505157 — o §2%
& = Iz
g5 5107 -5 go"
* =
0 54 F-1007" -2
15 0+ e 80 -4
-20 -5 T T T T T T T T T -z00 6
0.o0 005 o0 015 oz0 025 0.z0 025 0.40 0.45 050
Time (seconds)

Function Generator Profile Settings I Gainsl Trajectory Limits | Position Paramsl Velodty Paramsl Measurementl

Move: Type: Ch 1| profile Velodty Trigger Setup |

* Relative {* Trap ch zl Following Error [ AutoSetup
" Absolute " 5Curve

v Single Trace
Ch 3 | Profile Acceleration  sing

o I [~ Auto Scale Lock
Distance: I 50000 counts Actual Current

Trace Time: IS[J[J ms VI
Ch 5 | Disabled
. +
ch 6 | Disabled Sample Rate: 250 ps

Start | Stop |

él Record Stop Trace | Clear | Close
| |
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14.2 Menu, Display and Controls

14.2.1 File Menu
File
I

The File menu contains the options to save/restore scope settings. This feature is useful for saving custom
settings used for tests that are run frequently.

Menu Item Action

Save Settings Saves current scope settings to afile

Restore Settings | Restores settings from afile

14.2.2 Display
To access the Trace Display menu, Right-click in the trace display area

Trace Status: Ready

0 40 70000

g 251 [eso0o0

=} 204 [eso000
I 4 251 //(7 240000 ;
£ 2 Eanq Line Style  » JCRGE 820000 =
c £ g
£ 0 157 =" Preferences b plus [ 8200005
i 3
@ =) i L S
2 2310 connected plus 810000@

<4 57 00000

s oA [~ [790000

E:] -5 720000

-0 -10 T T T T T T T T T T T T 70000

0.o0 0oz 0.04 0.06 0.0 o0 01z 014 06 o.1g oz0 0zz 024 026
Time (seconds)

Menu Parameter Description
Line Style |line A line connects the plotted data points.
plus The Scope plots data points as plus signs, with no connecting line.
connected | Data points are plotted as plus signs and are connected with a line.
plus
Preferences | anti- When anti-aliasing is selected, the Scope removes screen-related jaggedness in

aliasing the displayed trace. Use of this feature may slow down the refreshing of traces on
slow computers.

grid When selected a grid is displayed on the scope screen.
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14.2.3 Trace Display Zoom
1.
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Hold the left mouse button down while dragging a box around the area of interest.

Trace Status: Ready

& 40 1020000 10

5 35 F1ofo000 &

4 30 i F1o00000 6

3 25 Fesooon 5 4 @

= 2
Tz E 204 Fo20000 %; z L
= = ™, o
$1 215 -M Foroooo 2 o £
S 3 / L 2 ;

oz 950000 3 -2 3

-1 5 / Fa50000 -4

2 o Foqo000 -6

ER Fozoooo .2

<4 10 T T T T T T T T T T T T Q20000 -0

000 002 004 008 008 040 042 044 046 048 020 022 024 026
Time (zecaonds)
2. Release the button to let the display zoom in on the selected area.
Trace Status: Ready

6 40 1020000 10

5 35 F1ofo000 &

4 20 P 1000000 &

3 _254 resoooo 2 4 §
2 € EX
Fz Sz04 resooon 5 2 g
- P N o F
51 215 arooo0 2 0 2
3 \/ : 3

o710 /-950000 =z

1 5 Fosooon -4

2 O ! Foqo000 -6 Q

-3 -8 T T T T T T T T T 230000 B

0.00 0.01 0.0z 003 0.04 008 0.08 007 0.08 0,09 0.10
Time (seconds)

3. Torestore the normal zoom level immediately, left-click anywhere on the trace. (Normal zoom level is

also restored when the next trigger event occurs.)
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14.2.4 Controls

l'_j [ Record ] [ Stop Trace ] [ Clear ] [ Close ]

>
o
=
o
5

Description
Save atrace. See Scope Trace Files

— Begins recording a trace

Stop Trace Stops recording a trace

Clear Clears the trace from the screen and trace data from buffer

Jn

[] AutoSetup
Single Trace
[] Auto Scale Lock

Trace Time: .1.255 v.

Sample Rate: 500 ps

Function Description

Auto When selected, the scope will be set up based on the setting for either the Function or Profile
Setup Generator (whichever is active).

Single When selected only one trace will be collected and displayed, otherwise a new trace will be
Trace started as soon as the current trace is displayed.

Auto When displaying the trace data, the scope will automatically scale the vertical axis for optimal
Scale viewing. When Auto Scale Lock is selected, the y-axis scale will be locked at is current setting.
Lock

Trace This is the total amount of time the trace is recorded.

Time

Sample |The rate at which each sample is collected. When tracing multiple channels, all channels are
Rate collected at approximately the same time.
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14.3 Function Generator

The Function generators can provide inputs to the different control loops for tuning and diagnostics purposes
without using an external control source.

Function Generator

Apply To: ’h'

Function: .SquareWave v.
Amplitude: 200 | mmjs

Freguency: 5| Hz

[ Start ] [ Stop ]

The Start button starts the function or profile generator. The Stop button stops the generator and aborts any
profiles in progress.

Parameter Description

Apply To | Control loop to which the Excitation will be applied: Current (available in all modes), Velocity
(available in velocity or position mode), or Position (available in position mode only).

Function |Function that will be applied to the control loop selected in the Apply To list box. The choices
vary with the control loop selected:

Selected Control Function Available

Loop

Current Sine Wave, Square Wave, Step Forward, Step Forward and Reverse,
and Impulse

Velocity Sine Wave, Square Wave, Step Forward, Step Forward and Reverse

Position Sine Wave, Square Wave

Amplitude | Amplitude of the command. Units vary depending on the value chosen in the
Apply To field.

Frequency | (Sine Wave and Square Wave only.) Frequency of input command cycle.

Period (Step Forward, Step Forward and Reverse, and Impulse only.) Duration of each input pulse.
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14.4 Profile Generator
Function Generator | Profile

Move Type:
@ Ve () Trap
() Absolute @ S Curve

Distance: 2000 counts

["] Reverse and Repeat

Parameter | Description

Move Relative: Moves axis a specified distance from the starting position.

Absolute: Moves axis to a specific position.

Type Trap or S-Curve.
Distance Distance for Relative move.
Position Target position for Absolute move.

Reverse and | (Relative move only.) When selected, will continuously generate forward and reverse moves
Repeat of the distance specified until Stop is pressed.
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14.5 Trace Channel Variables

Settings I Gainsl Trajectory Limiisl Position Paramsl Velocity Pai

Ch 1| Profile Velocity

£

Following Error

Ch 3| Actual Current

Ch 4| Profile Acceleration

Ch 5 | Disabled

Ch & | Disabled

Click the Channel button to open the Trace Variable selection screen

Channel 1 Trace Variables @
Category Trace Variable
Disabled
Current Commanded Velocity
Limited Velocity
Position Actual Motor Velocity
Acceleration Velocity Error
Voltage Actual Load Velocdity
Miscellaneous Unfiltered Motor Velocity
Digital Inputs Velocty Loop P Gain
Digital Outputs Velodty Loop I Gain
Event Status Faults
Event Status Warnings
Event Status Misc.
Raw Encoder Signals

Apply To: |#fxis A

Category Trace Variable

Disabled <Channel disabled, no associated variable>

Current Commanded Current, Actual Current, Limited Current, 12T Amplifier Accumulator,
I2T Motor Accumulator.

Velocity Profile Velocity, Commanded Velocity, Limited Velocity, Actual Motor Velocity, Actual
Load Velocity, Unfiltered Motor Velocity, Velocity Error

Position Commanded Position, Limited Position, Actual Load Position, Actual Motor Position,

Following Error, Passive Load Position

Acceleration

Profile Acceleration

Voltage

Analog Command, Bus Voltage, Analog sin Input, Analog cos Input, Terminal Voltage
Stepper, Terminal Voltage Servo

Miscellaneous

Motor Phase Angle, Amplifier Temperature, Hall States

Digital Inputs | Digital input line states
Digital Digital output line states
Outputs

Event Status
Faults

Short Circuit, Amp Over Temperature, Over Voltage, Under Voltage, Motor Over
Temperature, Feedback Error, Motor Phasing Error, Following Error, Command Input Fault,
Amplifier Fault (a latched fault is active).

Event Status
Warnings

Current Limited, Voltage Limited, Positive Limit Switch, Negative Limit Switch, Following
Warning, Velocity Limited, Acceleration Limited, Positive Software Limit, Negative
Software Limit, Pos Outside of Tracking Window, Vel Outside of Tracking Window.
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Category Trace Variable

Event Status
Misc.

Amp Disabled by Hardware, Amp Disabled by Software, Attempting to Stop Motor, Motor
Brake Active, PWM Outputs Disabled, Position Has Wrapped, Home Switch Active, In
Motion, Phase Not Initialized.

Raw Encoder
Signals

Primary Encoder A, Primary Encoder B, Primary Encoder X, Primary Encoder S,
Secondary Encoder A, Secondary Encoder B, Secondary Encoder X, Secondary Encoder
S
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14.6 Trigger Setup
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Click the Trigger Setup button to open the Trigger Settings screen.

Trigger Settings @
Trigger Type: :Above Level -

Trigger On: :Channel 1 -

Position: :Lef't -

Level: IDD| rpm

Event Status Bit: Select

Setting Description

Trigger Type Type Condition
Immediate Trigger Trigger as soon as a trace is started (when the
Record button is pressed).
Rising Edge Trigger when the selected channel's input changes
from below to above the trigger level.
Falling Edge Trigger when the selected channel's input changes
from above to below the trigger level
Above Level Trigger as soon as the selected channel's input is
greater than or equal to the trigger level.
Below Level Trigger as soon as the selected channel's input is
less than or equal to the trigger level.
Function Generator Trigger on the start of the next function generator
cycle.
Input Level High/Lo Trigger when specified input is high or low
Output Active/lnactive Trigger when specified output is active/inactive
Event Status Rising Edge/Falling Trigger on the rising or falling edge of an event
Edge status bit.
Raw Encoder Signal Level H/Lo Triggers when the raw encoder signal is Hi/Lo
Trigger On Selects which channel will be used as the trigger source.
Position Selects placement of the trigger event on the screen. (Value is not configurable for
Immediate or Function Generator trigger types.).
» Left for optimal viewing of events following the trigger.
» Middle for optimal viewing of events preceding and following the trigger.
» Right for optimal viewing of events preceding the trigger.
Level Sets the trigger level, in units appropriate to the channel selected.
Event Status With an event status trigger type selected, choose the status bit that will trigger the trace.
Bit For descriptions of the event status word.
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14.7 Measurement Tab

The Measurement tab allows you to measure and analyze data from up to three parameters during an interval
defined by adjustable cursors. The Cursor Data area displays a parameter’s values at the left and right cursor
locations, and the difference between the two values. The Analysis area displays the minimum, maximum,
average, and root mean square of the parameters during the cursor period.

Cursors
) oscilloscope
File

ol x|
|l |l
v Trace Status: Ready ¥
] 40 1070000 10
5 354 1060000 8
4 309 F1050000 &
3 254 ¥ 1040000 4 4 g
- o 1
g e b /\A/\m [ o |
E 1518 F0z00002 0 o
£ 5 2 3
S0 F 104 / 000003 2 3§
s 73
167 F1000000 -4
2 0 830000 Bl
3 5 % 920000 -8
4 10 T T T T T T T T T T T T 970000 -10
0.00 0.0z 0.04 0.08 o.0s8 0.10 012 014 016 018 020 02z 024 026
Time (seconds)
Function Generator Profile Settings | Gains | Trajectory Limits | Position Params | Velocity Params Measurement |
Cursor raw data Cursor Data lysi
Left ight Delta Min Max Av rms  Units
Move: Type: Rig 9 i
" Relative = Trap Time: 0.0871 0.1738  0.0867 s
" Absolute " sCurve m 20 30 rpm
C— %0000 | counts CH2 » 1009443 1032211  22768| 1009443 1032211 1020844 1020866 counts
R, CH3 » 0.94 166 0.72 0.7 179 1.28 A
Start | Stop
| Stop Trace | Clear I Close

Cursor data analysis

When Show Cursors is not set, the Cursor Data fields are inactive and the Analysis fields show calculations

based on data from the entire trace cycle.

1. Todisplay cursors and activate the Cursor Data fields, set Show Cursors.

Show Cursors

2. Tomove a cursor, click on the cursor and hold the left button while dragging the cursor to the desired
location. Release the left button to place the cursor in the new location.

3.

_char_mel__lists on the Measurement tab:
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14.8 Control Loop Parameters

The Oscilloscope provides convenient access to all of the control loop parameters that might be used in
tuning and diagnosing an amplifier. The user can adjust these parameters and see the results immediately on
the scope. Control loop parameters are accessed through a set of tabs, shown below.

| Setﬁngs| Gains |Trajech::r\-I Limits I Position Params I Velodty Params I Measurement|

Position Velodty Current
Pp: w00 © Vp: 203 Cp: 08|
Aff: o * Vi 43| * Ci: 223

vt | 16384

Note that the parameters represented on these tabs can also be accessed through the screens used to
configure the control loops and the digital position input. Changing a value in the Scope tool automatically
updates the value on the other screens where it appears, and vice versa.

Control loop parameter tab descriptions follow.

14.8.1 Gains Tab

Modes Gains Description For More Information
Position mode only Pp Position loop proportional gain. | "Position Loop Gains" (= p. 67)

Aff Acceleration feed forward.

VFf Velocity feed forward.

Position or velocity mode only |Vp Velocity loop proportional gain. | "Velocity Loop Gains" (= p. 57)

Vi Velocity loop integral gain.
All modes Cp Current loop proportional gain. | "Current Loop Gains" (= p. 51)
Ci Current loop integral gain.
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14.8.2 Trajectory Limits Tab
Available in position mode.

Setﬁngsl Gains Trajectory Limits I Position Paramsl Velocity Paramsl Measurementl

Maximum Velocity: |—3‘5 rpm
Maximum Acceleration: I 20 rps2
Maximum Deceleration: I 20 rps2
Maximum Jerk: I 47264 rps?

For more information see "Position Loop Setup and Tuning" (= p. 59)

14.8.3 Position Loop Parameters
Available in position mode.

Setﬁngsl Gainsl Trajectory Limits Position Params I Velocity Paramsl Measurement

rPosition Tracking———————————— ”
Actual Position: 1049375 counts
ﬂindow:l 4130 counts
Time: I—ID 'T[f} Set Zero Position |
Following Error: I 16520 counts

[ Disable Following Error Fault

Set Zero Position sets the amplifier's actual position count to zero. For more information, see "Position Loop
Setup and Tuning" (= p. 59)

14.8.4 Velocity Loop Parameters
Available in position and velocity modes.

Setﬁngsl Gainsl Trajectory Limiisl Position Params  Velodity Params I Measurement

Velodty Tracking

ﬂindow:l 145 rpm Acce] Limit: I 200 rps2
Time: I 100 ‘ms Decel Limit: I 200 rps?

For information see "Velocity Loop Setup and Tuning" (=» p. 52)
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14.9 Scope Trace Files

The Oscilloscope can save trace data to disk that can be opened later with the Trace Viewer. When the save
trace data to disk operation is performed, RGM WorkBench saves the data in three different files:

« .sco: This is a RGM WorkBench format which contains scope settings and trace data

« .csv: This is a standard comma-separated value file format that can be imported into spreadsheet soft-
ware like Microsoft Excel.

« .txt: This is a tab-separated value file similar to the .csv file. This is intended to be imported by soft-
ware that can only read tab-separated values.

The format of the .csv and the .txt files are identical except for the separator:

o Column 1: time

« Column 2: Trace Channel 1 data

o Column 3: Trace Channel 2 data (if used)
o Column n: Trace Channel n data (if used)

The trace data is in amplifier units, not user units (see Parameter Dictionary for units).
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14.10 Trace Viewer

The Trace Viewer screen displays the contents of .sco files. All of the trace display features (zooming, line
style, etc.) as well as the measurement functions are available in this screen.

1. Onthe Main screen, choose Tools=>View Scope Files to open the window.
2. Click Open File. When prompted, select the name of the file you wish to open. Then, click Open to dis-
play the file in the Trace Viewer window.

22 Trace Viewer - O *

a4

Current(®)

[=J I = )
P T S

14
24

-3 T T T T T T T T T T T T T T T T T T T

000 025 050 075 100 125 150 475 200 225 250 275 300 325 350 375 400 425 450 475 500
Time (zeconds)

Measurement
Function Generator Scope Trigger
Ch 1: Commanded Current Type: Rising Edge
Apply To:
Ch 2: Actual Current
Excitation: Apply To: Channel 1
Ch 3: Actual Current U
Amplitude: il Ch 4: Actual Current V Position: ~ Left
Period: Hz Ch 5: Disabled Level: 2A
Ch 6: Disabled
Trace Time: 35
Open File Close
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15 Filters

15.1 Setting Parameters

To change or view filter configurations follow these steps:

1. Choose the Configure Filters button from the main screen to open the Filter Configuration screen.
[ Configure Filters ]

2. Toview present filter settings choose the Filter Settings tab. Choose other tabs to configure Analog, V
Loop, | Loop or Input Shaping settings.

m Filter Configuration

S —

15.2 Filter Configuration Windows

Along with the location of a cut-off frequency on the filter curve, there are several filter configuration
parameters available depending on the initial choice of: Standard Filter Types and Standard Filter Families.

Filter configuration choices may include:

« Number of Poles (the location of a cut-off frequency on the filter curve)
« Cut Off Frequency

« Frequency 2 (If two poles are chosen)

« Pass Band Ripple

« Stop Band Ripple

15.3 Filter Settings

The Filter Settings tab opens a window that shows what filters have been selected.

w Filter Configuration - *
Analog Vloop Iloop InmputShaping
Type Family Poles Freguency

Analog Reference Disabled

 Loop Input Disabled

W Loop Quiput 1 Low Pass Butterworth 2 200

V Loop Qutput 2 Disabled

 Loop Qutput 3 Disabled

I Loop Input 1 Disabled

I Loop Input 2 Disabled

Input Shaping Disabled 0.1

Close

Kollmorgen | kdn.Kollmorgen.com | February 2019




RGM WorkBench User Guide | 15 Filters

15.4 Input Shaping

Input shaping is a method by which unwanted command induced vibrations are kept to a minimum by
damping them with superimposed impulses. This produces a command that will drive the system with limited
residual vibration.

In order to set the input shaping parameters, first measure the mechanical frequency; see .
Below is a diagram of the input shaping process.

Step Command Input QOutput Command
Shapi
A aping A
Time - T , Time
0 0 T

Below is a sensitivity curve. When F = Fm, there is zero vibration.
25—

20 —

15 —

10 —

Percentage Vibration

0.6

Frequency (F/Fm)
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15.4.1 Analog

The Analog tab opens a window that shows analog filter choices and a representative curve. Modify the
settings as needed and press Apply.

2 Filter Configuration - *

Filter Settings  Analog Vioop Iloop Input Shaping

Analog Reference Input 3 Analog Reference Selected Loop Input
Filter

Type: Apply
Family: | Butterworth bt
Default
() 1pole (@ 2Pole
Cut Off Frequency (Fc) 200 |Hz 45
Frequency 2 (F2) 1|Hz t N -40dB
decade
Pass Band Ripple (Rp) 0.1|db
Stop Band Ripple (Rs) 1|db
FIC

Close

15.4.2 Velocity Loop

The V Loop tab opens a window that shows Velocity Loop filter choices and a representative curve. Modify
the settings as needed and press Apply. Selecting Default will supply a 200 Hz Low Pass filter to the first
velocity loop output filter.

2 Filter Configuration - *

Filter Settings  Analo Iloop Input Shaping

a ==
M_b(vuomy&m_ Input ’_»( Velocity ’_‘
Limiter Filter Controller

o ded
Output Output Output Current
Filter 1 Filter 2 Filter 3

Type: Low Pass v Apply

(O Input Filter

(® Output Filter 1
Family: Butterworth w
(O Output Filter 2 Default

() 1pole (@ 2Pole

(O Output Filter 3

Cut Off Frequency (Fc) 200 |Hz g4

Frequency 2 (F2) 1|Hz t N -40dB
decade

Pass Band Ripple (Rp) 0.1|db

Stop Band Ripple (Rs) 1|db

Fc

Close
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15.4.3 Current Loop

The | Loop tab opens a window that shows Current Loop filter choices and a representative curve. Modify the

settings as needed and press Apply.

2 Filter Configuration - *
Filter Settings Analog VLloop ILoop  Input Shaping
o e
EenComd o, | Input Current Current Vol
5 Filter 1 Filter 2 Limiter Conroller
Offset
Type:
@ Input 1 ype ~ Apply
Family: Butterworth w
O nput 2 Default
@ 1pole () 2Pole
Cut Off Frequency (Fc) 0| Hz a5
\ -3dB
Frequency 2 (FZ)
q ¥ e 0 |Hz 2048
Pass Band Ripple (Rp) 0ldb decade
Stop Band Ripple (Rs) 0|db
Fc
Close
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15.5 Standard Filter Types

15.5.1 Low Pass Filter

Frequencies below the selectable cut-off are allowed to pass.

Example:

dB

4 -3dB
-40dB
decads

Fc

15.5.2 High Pass Filter

Frequencies above the selectable cut-off are allowed to pass.

Example:

dB
3dB

40dg
decade

Fc

RGM WorkBench User Guide | 15 Filters
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15.5.3 Notch Filter

Notch filters allow a bandstop in a range between two selectable frequencies. It may be Butterworth (no
ripple), Chebyshev (selectable passband ripple), or elliptical (ripple on both passband and bandstop).

Example:
dB Jr

&

_T_

Rp

Fi F2

15.5.4 Band Pass Filter

Band pass filters allow a range of frequencies, between two selectable cut-offs, to pass. It may be
Butterworth, Chebyshev, or Elliptical.

dg l

Rp

F1 F2

15.5.5 Custom Biquad Filter

The Bi-Quadratic filter has two quadratic terms: one in the numerator, and one in the denominator. The
numerator affects the filter's two zeros and the denominator affects the filter's two poles. Many filter classes
and types can be expressed in the Bi-Quad form by entering the coefficients. The coefficients can be
calculated using any commercially available math software package and entered as floating point numbers.
However, due to the fixed-point representation, the numbers may be rounded.

Example:

-1 -z
bn +b1z +hzz

-2

4] -1
1+az+az
1 z
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15.6 Standard Filter Families

15.6.1 Butterworth Filter
A Butterworth filter has two poles for faster roll-off at the cut-off frequency.

Example:

dB

4 -3dB
-40dB
decads

Fc

15.6.2 Chebychev Filter

A Chebysheyv filter has a faster roll-off than a Butterworth filter, but, as a result of the fast roll-off, ripple is
introduced into the passband frequency.

Example:
dB l
T
Rp

15.6.3 Elliptic Filter

Similar to a Chebyshev filter but ripple is introduced into both the passband and the stopband. It has a faster
roll-off than a Chebyshev filter.

Example:
dB l
T
Rp
Rs
4
y T
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15.7 Measuring Mechanical Vibration

There are several ways to measure mechanical vibration. Two choices are offered below.

15.7.1 Using an Accelerometer with RGM WorkBench

Begin with a Kollmorgen drive operational and controlled by RGM WorkBench.

1. Connect the accelerometer analog output to Kollmorgen drive’s Analog + and - on the signal input as in
the diagram below.

Accelerometer Copley Drive
{Analog Devices ADXL1056)

Vdd 5V

Com GND
Al AIN +

Com AIN -

On RGM WorkBench, click the Scope Tool. E
Select the Measurement tab, choose a channel, select Voltage, then Analog Command.
Perform a move.

After the move is complete, measure Tm (1/Fm), which is the period of mechanical oscillation.

arLN

15.7.2 Using RGM WorkBench to Monitor Following Error
Monitor the following error using RGM WorkBench'’s scope option.
Begin with a Kollmorgen drive operational and controlled by RGM WorkBench.

On RGM WorkBench, click the Scope Tool E
Select the Measurement tab, choose a channel, select Position, then Following Error.
Perform a move.

After the move is complete, measure Tm (1/Fm), which is the period of mechanical oscillation.

AN~
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16 Frequency Analysis

16.1 Frequency Analysis Overview

The Frequency Analysis screen expands on the functionality of RGM WorkBench by providing a tool to
measure the frequency response of a system while running a sine sweep. This further enhances the ability to
tune and troubleshoot systems, particularly when there is a mechanical resonance present. The frequency
analysis tool will measure and plot the current/velocity loop frequency response on a semi-log graph.

« Click i to open the Frequency Analysis screen.

f_ Frequency Analysis i =l
File View
ekd - K
Plot 1 LI|
4 0
24 ro
29 % F-10
14 F-20
u} F-20
-1 -0
- F-sn 3
o M
Z -3 F-60 o
2
ERER F-70 g
5 .54 F-20 &
= £
= 54 Faoo =
-7 F-100
24 r-110
-0 F-120
-0 4 r-120
=119 r-140
12 T T T T T T T T T T T T T T T T T T T T -150
0 100 1000 2000
Frequency (Hz)
W Maanitude [ Phase Shift
Sine Sweep I Log | Measurement | Plot Settings
Mode: ICIosedLoopCurrent LI Fregq = 1052 H=z, Mag = -1.74 dB, Phase = -59.38 deg ;I
Fregq = 1182 H=z, Mag = -2.04 dB, Phase = -86.23 deg
) Fregq = 1328 H=z, Mag = -2.42 dB, Phase = -73.76 deg
Amplitude: I 0.5 Freg = 1492 Hz,  Mag = -2.88 dB,  Phase = -81.98 deg
F: = 1676 Hz Mi = -3.45 4B Fhi = -50.93 4
Start Frequency: I—ID Hz £=d 8 HE 2d ! ase =J
Fregq = 1883 H=z, Mag = -4.,12 dB, Phase = -100.51 deg
End Frequency: I 3000 Hz Fregq = 211§ H=z, Mag = -4.34 dB, Phase = -110.94 deg
Fregq = 2377 H=z, Mag = -5.90 dB, Phase = -121.76 deg
Mumber of Samples: I 50 Freq = 2870 H=z, Mag = -7.01 dB, Phase = -133.18 deg
Freg = 3000 H=z, Mag = -8.31 dB, Phase = -144.91 deg
Start | Sine sweep complete
-
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16.2 User Interface

16.2.1 Graph

The frequency response data is plotted on a semi-log graph when the sign sweep completes. Eachtime a

sine sweep is run, the data is plotted on a graph in a new tab. The tabs are named with the plot number (Plot
1, Plot 2, etc.). For multi-axis drives, the axis letter is appended to the tab name (e.g. Plot 1A, Plot 2B, etc.).
The magnitude scale is displayed on the left Y axis and the phase shift scale is displayed on the right Y axis.

Plot1 x |Plot2 % [Plot3 x

1 &0
04 40
—" —
-1 rzo
24 ro
EE —_— F-zo
= 2
5 .4 40 8
= o
- L w
2° 80 I
5 a
E -6 F-e0 g’
7 100
2 120
-0 -140
10 r-160
11 T T T T T T T T T T T T T T T T T T-120
0 100 1000 2000
Frequency (HZ)

W Maanitude ] Phase Shift

16.2.2 Graph Options Menu

To display the plot options menu, right-click anywhere on the graph.

LineStyle ¥ @ | line
Preferences | plus

connected plus

100
Menu Menu Description
Items
Line Style |line A line connects the plotted data points.
plus The Scope plots data points as plus signs, with no connecting line.
connected | Data points are plotted as plus signs and are connected with a line.
plus
Preferences | anti-ali- When anti-aliasing is selected, the Scope removes screen-related jaggedness in
asing the displayed trace. Use of this feature may slow down the refreshing of traces on
slow computers.
grid When selected a grid is displayed on the scope screen.
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16.2.3 Sine Sweep Controls

Sine Sweep I

Mode: ICIosed Loop Current LI
Amplitude: | 0.5 A
Start Frequency: I 10 Hz
End Frequency: 3000 Hz

Mumber of Samples: I 50
Start | Stop |

Control | Parameters Description

Apply To/ | Description | The control loop to which the sine wave will be applied. The options are current
Mode and velocity.
Units None
Default Closed Loop Current
Amplitude | Description | The amplitude of the sine wave.
Units A (current), rpm (velocity, rotary motor), mm/s (velocity, linear motor).
Default Current: 10% of the current loop continuous current.
Velocity 5% of the velocity loop velocity limit.
Start Fre- | Description | The first frequency of the sine sweep.
quency Range 1t0 9999 Hz (whole numbers only)
Units Hz
Default Current: 10 Hz
Velocity 5Hz
End Fre- |Description | The last frequency of the sine sweep.
quency Range 2 to 10000 Hz (whole numbers only)
Units Hz
Default Current: 3000 Hz
Velocity 250 Hz
Number of | Description | The number of sine wave frequencies to run during the sine sweep. The fre-
Samples quencies are calculated so that there are an equal number of frequencies per dec-
ade.
Range 2t0 100
Units None
Default 50
Start Description | Starts the sine sweep.
Units N/A
Default N/A
Stop Description | Cancels the sine sweep in progress.
Units N/A
Default N/A
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16.2.4 Log Text Window

The log text window shows the progress of the sine sweep. For each frequency, the measured frequency
response (magnitude and phase shift) is displayed. These are the values that get plotted in the graph.

easurement

= T = T =
Freq = 834 H=z, Mag = -1.33 db, Phase = -58.91 deg i
Freq = 937 H=z, Mag = -1.89 db, Phase = -£5.74 deg
Fregq = 1052 H=z, Mag = -2.13 db, Phase = -73.09 deg
Fregq = 1182 H=z, Mag = -2.84 db, Phase = -80.93 deg
Fregq = 1328 H=z, Mag = -3.23 db, Phase = -89.29 deg
Freg = 1432 Hz, Mag = -3.89 db, Phase = -98.24 deg
Freq = 1876 H=z, Mag = -4.89 db, Phase = -107.686 deg
Fregq = 1883 H=z, Mag = -5.55 db, Phase = -117.74 deg
Fregq = 211§ H=z, Mag = -§.52 db, Phase = -128.32 deg
Fregq = 2377 H=z, Mag = -7.67 db, Phase = -139.30 deg
Freq = 2870 H=z, Mag = -8.87 db, Phase = -151.32 deg
Freg = 3000 H=z, Mag = -10.24 db, Phase = -163.87 deg £
Sine sweep complete | &

16.2.5 Measurement
The Measurement tab contains tools to analyze the data displayed on the graph.

16.2.5.1 Cursors

Show Cursors

Select to display the cursors on the graph.
Plot1 x| Plot2 x] |
4 0
3‘-——____,_______‘_______ o
24 F-10
19 \ .20
0 F-30
EE F-40
a2 r-s0 2
- X F-60 @
5 w
:E -4 r-70 E
= -80 ‘o
2 5 % Lo &
7 F-100
24 r-110
-0 F-120
10 F-120
117 F-140
1z T T T T LI B T T T T T T T T T T-150
0 100 1000 2000
Frequency (HZ)

To move the cursors, left-click a cursor and drag it to the left or right. As the cursor is moved along the plot,
the values for Frequency, Magnitude, and Phase Shift are updated in the Measurement tab.

Log Measurementl Flot Settingsl

Left Right Delta v &
R 64 466 402 [~ Show -3dE Line
Magnitude: -0.47 -0.75 0.28 [~ Show 0 dB Line %

I~ show -180 deg Line
Phase Shift:
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16.2.5.2 Show -3db Line

to display a horizontal dashed line where the magnitude is -3db. The -3db point on
the magnitude plot is used to determine the bandwidth of the system.

Plot1 x
1 40
04 2o
__...-"‘\ —

T
]
=]

r-100

Magnitude (db)
o
o
(Bap)pys 2seyy

Frequency (HZ)

to display a horizontal dashed line where the phase shift is -180 degrees. This line
is useful for determining the phase and gain margins of your system.

Plot1 x
5 400
0 350
5 o
10
15
-209 160 o
Iy &
T25 F1o0 %
2 | w
2 =20 g
525 @
-3 o
= &
-40
45
-50 1
-55 1
601
-G5S T T T T
5
Frequency (HZ)
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16.2.6 File Menu

f_ Frequency Analysis

File View

File Menu Items | Description

Save Current Plot | Saves the data from the sine sweep of the plot currently displayed in a csv format that
can be imported to other software such as spreadsheets or mathematical analysis pro-

grams.
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17 Data, Firmware, and Logs

17.1 Amplifier RAM and Flash Memory

17.1.1 Amplifier RAM

« Volatile. Contents erased when amplifier is reset or powered off.

« Initial contents read from flash on power-up. Contents then updated in real time to reflect certain oper-
ational conditions and changes entered with RGM WorkBench software. At any time, the user can use
RGM WorkBench to restore data from flash into amplifier RAM.

17.1.2 Flash

« Non-volatile. Contents retained when the amplifier is reset or powered off.

« Modified only by using a Save to Flash tool or by closing certain screens (Motor/Feedback, Basic
Setup, Homing, or CAN Configuration), whose contents are automatically saved to flash upon closing
of the screen.

Parameters reside in RAM only, Flash only, or both RAM and Flash. The table below illustrates the typical
parameter locations. Refer to the Parameter Dictionary for information about specific parameters.

Data Resides In Datai

Flash only This category includes all Motor/Feedback screen data and Basic Setup screen
(motor/feedback data only), This data is saved to flash when the user confirms
the values and closes the screens without canceling.

Amplifier RAM only Includes operating status data such as actual position, actual current, and amp-
lifier temperature. Such data is never stored in flash. It is destroyed from amplifier
RAM with each power-down or amplifier reset.

Flash and amplifier RAM | Includes all other data not represented in the two categories above. When chan-
ging these parameters in RGM WorkBench, the value is saved to amplifier RAM
only. To save these values to flash, the Save To Flash operation must be per-
formed or data will be lost on power down or reset.
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17.2 Data Management Tools

17.2.1 Amplifier

Operations performed using the amplifier data management tools at the top of the Main screen (shown below)
affect amplifier settings, including motor/feedback data. (CVM Control Program data is not saved by these
operations).

ﬁ RGM Workbench V.0 Beta 6 (801-1896 X-Axis)

File Amplifier Tools Help . Data
10 S| (Lﬁ e 2p o Man%%%nent
T -

Action Name Description

d Save amplifier | Saves both amplifier and motor/feedback data to a disk with a .ccx filename
data to disk extension.

= Restore Restores amplifier and motor/feedback data from a .ccx file to the amplifier's
amplifierdata |RAM, or flash for the flash only variables. See Parameter Dictionary for parameter
from disk descriptions.

A To Flash operation should be performed to insure that all data is saved to flash

Save amplifier | Saves contents of amplifier RAM to amplifier flash memory.

-" datato flash
<

Restore Restores contents of amplifier flash memory to amplifier RAM.
amplifier data
from flash
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17.2.2 Motor Screen

Operations performed using the Motor screen data management tools only apply to the motor/feedback
parameters.

Motor Data

Management /E d '_ /

Tools

Action Name | Description

d Save Saves only motor/feedback data to disk with a .ccm filename extension. Amplifier data
motor that is not represented on the Motor/Feedback screen is not saved in this file.

datato

disk

= Restore |Restores only motor data from a disk file with a .ccm filename extension amplifier flash
motor (the motor/feedback parameters are flash only).

data

from

disk

_" Save Saves the contents of the Motor/Feedback screen from to amplifier flash memory.
motor Amplifier data that is not represented on the Motor/Feedback screen is not saved. Can

datato |be used to assure that all changes are saved to flash without closing the

flash Motor/Feedback screen.

“ Restore |Restores only motor data from amplifier flash memory to the PC. Amplifier data that is
motor not represented on the Motor/Feedback screen is not affected. Can be used before

data closing the Motor/Data screen to restore settings to the previously saved values.

from

flash
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17.3 Drive Configuration

The Plus Family of drives (Feature set E), have the capability of saving/restoring the entire drive configuration
to afile. The drive configuration consists of all parameters (RAM/Flash and Flash Only) and the entire
contents of the CVM flash, which includes any CVM programs, cam tables, and gain scheduling tables. The
file is saved with a .ccd file extension.

This feature is useful to clone drives in one step rather than separately loading each file (.ccx, .ccp, .cct,
.ccg). Additionally, the file is in XML format which can be read by some EtherCAT masters.

17.3.1 Save Drive Configuration

From the menu on the Main screen, select File>Save Amplifier Data, then choose a filename.

110 Kollmorgen | kdn.Kollmorgen.com | February 2019




RGM WorkBench User Guide | 17 Data, Firmware, and Logs

17.4 Firmware Download
The amplifier's flash memory holds the amplifier's firmware. As needed, perform the following steps to obtain
new firmware and download it to amplifier flash memory.

NOTE

« RGM WorkBench does not support downloading firmware to a node amplifier via a multi-drop gate-
way amplifier; a direct connection (serial, CAN) must be used.
« Tocheck the firmware version currently loaded, click the Amplifier Properties button or choose

Help—>About.

AWARNING |
Do not power down or disconnect the amplifier during firmware download.

1. Onthe Main screen choose Tools—>Download Firmware to open the Download Firmware window.
Browse to where the firmware file is located and click Open to start the download. The progress will

be displayed while downloading.
Q Firmware Download E'E@

Writing new FPGA and firmware image.

= 0%

When the progress dialog closes, the firmware download is complete.
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17.5 ErrorLog

’ Click the Error Log tool on the Main screen

ﬁError Log i =l

Hishoryl Frequencyl Metwork Siamsl Encoder Siamsl

Type Description
|Warning Phase not Initialized
B e

g Clear Log | Refresh | Close |

Tab / Button Contents / Description

Active Type and description of each active fault and warning. The contents of this tab are auto-
matically refreshed as new events occur.

History Type, description, and time of occurrence of each fault and most warnings since the log was
last cleared. The contents of this tab are not refreshed automatically as new events occur.
The contents are refreshed only when the tab is displayed or when Refresh is clicked.

Frequency Type, description, and frequency of each fault and warning that has occurred since the log
was last cleared. The contents are refreshed only when the tab is displayed or when Refresh
is clicked.

Network (Under CAN control only.) Status of CANopen network. Lists warnings and errors.
Status

Saves the contents of the History and Frequency tabs to a text file.

Refresh Updates the contents of the History or Frequency tabs.

Clears all History and Frequency entries in the drive.
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17.6 Communications Log

The communications log displays all communications between RGM WorkBench and the amplifier. The data
is only stored in the PC’'s RAM by RGM WorkBench; it is not part of the amplifier's data.

On the Main screen, choose Tools>Communications Log

2 Communications Log - O *

15:33:16.281 “\\.\COM1l& Send: Get Lmp Desired State in BAEM 00 7i%
15:33:16.318 “\\.\COM1l& Recv: Get Amp Desired State in RAM 00 35E
15:33:16.320 \W\.\COMl& Send: Get Trajectory Status Register 00
15:33:16.325 \\..\COMl& Recv: Get Trajectory Status Register GDS
15:33:16.325 “\\.\COM1&é Send: Get Camming Configuration 00 53 0O
15:33:16.327 “\\.\COM1l& Recv: Get Camming Configuration 00 4a 01
15:33:16.328 \\.\COM1l& Send: Get Latched Event Status Register
15:33:16.330 \\.\COMl& Recv: Get Latched Event Status Register
15:33:16.331 “\\.\COM1& Send: Get Event Status Register 00 £7 01
15:33:16.334 \\..\COMl& Recv: Get Event Status Register 00 88 0:Z
15:33:16.335 \\..\COMl& Send: Get Sticky Event Status Register (
15:33:16.337 \\.\COMl& Recv: Get Sticky Event Status Register (
15:33:16.338 \\.\COMl& Send: Get Latching Fault Status Registe:

15:33:16.340 \W\.\COMl& Recv: Get Latching Fault Status Regisriill
| | »

Enable Logging
[[] Enable Event Status Logging

[] show "Get Variable™ Cmds "_ﬂ Clear

Option  Descripon

Enable Logging | When selected, logging is enabled and all communications, with the exception of status
messages, are recorded in the log

Enable Event When selected, status messages are included in the log. Note that Show “Get Variable”
Status Logging | Cmnds must also be checked to log Event Status commands.

Show “Get Vari- | When selected, “Get Variable” commands are added to the log.
able” Cmds

d Saves the contents of the Communications Log to a text file.

Clears the log contents from the PC’'s RAM
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18 Virtual Amplifier

18.1 Overview

Virtual amplifiers can be used for creating amplifier and motor data files off line. A new virtual amplifier can be
created based on a virtual amplifier template file (.ccv) or from an existing .ccx file. RGM WorkBench
includes a set of .ccv files for each model that is supported.

1. Select the Virtual Amplifier node from the Kollmorgen Neighborhood. This will display the Open Virtual
Amplifier screen.

H RGM Workbench V2.0 Beta & {ED1-1396] Open Virtual Amplifier x

Select Method:

File Amplifier Tools Help

- @i
a @ !_: 1 | (O) Open existing amplifier (ccx) file
B

(O Open Drive Config (ccd) file
| Keollmorgen Neighborhoc

L ; BB virtusl Amplifier ____J oK Cancel

2. Create a new amplifier file
« Select Create new amplifier and click OK.
« When prompted, select the .ccv that represents the appropriate drive model.
« Click Open. The Basic Setup screen will be displayed.
« Motor and amplifier values may now be viewed, entered, and adjusted.

OR
Open existing amplifier file

« Select Open existing amplifier file and click OK.
« When prompted, select the appropriate .ccx file.
o Click Open.

« Motor and amplifier values may now be viewed, entered, and adjusted.
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19 Gains Scheduling

19.1 Gain Scheduling Overview

The Gain Scheduling feature allows you to schedule gain adjustments based on changes to a key parameter.
For instance, Pp, Vp, Vi, and Current Offset (A) could be adjusted based on changes to commanded velocity.

Gain adjustments are specified in a Gain Scheduling Table. Each table row contains a key parameter value
and the corresponding gain settings. The amplifier uses linear interpolation to make smooth gain adjustments
between the programmed settings.

Gain scheduling involves the basic steps outlined below. Details follow in the chapter.

Kollmorgen | kdn.Kollmorgen.com | February 2019 115




116

RGM WorkBench User Guide | 19 Gains Scheduling

19.2 Configure Gain Scheduling

1. From the menu on Main screen, choose Amplifier= Gain Scheduling.

m Gain Scheduling

File Edit
Config

Key Parameter:  [Disable Gain Scheduling

[] Use Absolute Value of Key Parameter
[] Disable Gain Scheduling Until Axis is Referenced

Select Gains

|:| Position Loop Pp Position Loop Pi

*

[ velocity Loap Vp Position Loop Pd
[ velocity Loop Vi
Current Loop Offset
E "_j -" “ Close
2. Choose the Key Parameter:

Key Parameter Description

Disable Gain Scheduling. Disable gain scheduling.

Use Written Parameter. An external controller can write to this parameter using any of several
protocols and corresponding parameter IDs: Kollmorgen ASCII Inter-
face or the Kollmorgen Indexer 2 Program (ID 0x128), CANopen and
EtherCAT(Index 0x2371), and MACRO I-variable (0x528).

See the Kollmorgen ASCII Interface Programmer’s Guide, the Koll-
morgen Indexer 2 Program User Guide, or the Kollmorgen CANopen
Programmer’s Guide.

Use Commanded Velocity. | Schedule gain adjustments based on changes to commanded velocity.

Use Actual Velocity. Schedule gain adjustments based on changes to actual velocity.

Use Commanded Position. | Schedule gain adjustments based on changes to commanded position.

Use Actual Position. Schedule gain adjustments based on changes to actual position.

3. Optionally set controls:

Control Description

Use Absolute Value of Key | If a velocity or position value is chosen for the Key Parameter and this

Parameter option is set, the Key Parameter is interpreted as an absolute value.

Disable Gain Scheduling When this option is set, the scheduled gain adjustments do not take

Until Axis is Referenced place until the axis is referenced (homed).

4. Select the gains that you wish to adjust by schedule. The choices are Pp, Vp, Vi and Current Offset
(A). For each gain you select, a column will be enabled in the Gain Scheduling Table.
5. Continue with "Set Up Gain Scheduling Tables" (=» p. 116)

19.3 Set Up Gain Scheduling Tables
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On the Gain Scheduling screen, open the Table tab:

2 Gain Scheduling - *
File Edit
Config Table
Key Value (counts) F Loop Pp  Loop Vp W Loop Vi Current Offset (A) F Loop i F Loop Pd
o | o 10 20| 20| | |
1] 5000000 20] 20| 20| | |

CVM memory usage: NfA |—<\ m
s

“ERR

Close

B

Action Description

Creates a new table

Deletes the table from the amplifier flash and PC's RAM

Saves configurations and table to disk

Restores configuration and table to PC only

Saves configuration and table to amplifier flash

|
o
3
>
*

Restores configuration and table from amplifier flash to PC. This operation overwrites all data on
the Gains Scheduling screen.

N —~

w

&

. Onthe Gain Scheduling screen, open the Table tab:

Click the Create New Table button C and enter the number of lines for the table.

2 New Table X
Enter Number of Lines: 2
oK Cancel

Enter the Key Parameter and gain adjustment values.

NOTE

« All values must be whole numbers (no fractional values)
« All Key Values must be increasing

After all values have been entered, click the Save Table button. = This action saves both con-
figuration and table data.
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20 Appendix: I°T Time Limit Algorithm

20.1 I’T Time Limit Algorithm Overview

The 12T current limit algorithm continuously monitors the energy being delivered to the motor using the 12T
Accumulator Variable. The value stored in the 12T Accumulator Variable is compared with the 12T setpoint
that is calculated from the user-entered Peak Current Limit, 12T Time Limit, and Continuous Current Limit.
Whenever the energy delivered to the motor exceeds the 12T setpoint, the algorithm protects the motor by
limiting the output current or generates a fault.

20.1.1 Formulas and Algorithm Operation

20.1.1.1 Calculating the 12T Setpoint Value

The 12T setpoint value has units of Amperes2-seconds (A2S) and is calculated from programmed motor data.
The setpoint is calculated from the Peak Current Limit, the 12T Time Limit, and the Continuous Current Limit
as follows:

12T setpoint =
(Peak Current Limit2 — Continuous Current Limit2) * I2T Time Limit

20.1.1.2 Algorithm Operation

During amplifier operation, the 12T algorithm periodically updates the 12T Accumulator Variable at a rate
related to the output current Sampling Frequency. The value of the 12T Accumulator Variable is incrementally
increased for output currents greater than the Continuous Current Limit and is incrementally decreased for
output currents less than the Continuous Current Limit. The 12T Accumulator Variable is not allowed to have a
value less than zero and is initialized to zero upon reset or +24 Vdc logic supply power-cycle.

20.1.1.3 Accumulator Increment Formula

At each update, a new value for the 12T Accumulator Variable is calculated as follows:

12T Accumulator Variable 44 =
12T Accumulator Variable ,

+(Actual Output Current 412 — Continuous Current Limit2) * Update period

After each sample, the updated value of the 12T Accumulator Variable is compared with the 12T setpoint. If
the 12T Accumulator Variable value is greater than the 12T Setpoint value, then the amplifier limits the output
current to the Continuous Current Limit. When current limiting is active, the output current will be equal to the
Continuous Current Limit if the commanded current is greater than the Continuous Current Limit. If instead
the commanded current is less than or equal to the Continuous Current Limit, the output current will be equal
to the commanded current.
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20.1.2 Application Example

Operation of the I2T current limit algorithm is best understood through an example. For this example, a motor
with the following characteristics is used:

o Peak Current Limit—12 A

o 12T Time Limit—18

« Continuous Current Limit —6 A

From this information, the 12T setpoint is:

setpoint = (12 A2-6 A2)* 1S = 108 A2S

20.1.2.1 Plot Diagrams

The plots that follow show the response of an amplifier (configured w/ 12T setpoint = 108 A2S) to a given
current command. For this example, DC output currents are shown in order to simplify the waveforms. The
algorithm essentially calculates the RMS value of the output current, and thus operates the same way
regardless of the output current frequency and wave shape.

I*T current limit
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Figure 1: Diagram A

At time 0, plot diagram A shows that the actual output current follows the commanded current. Note that the
current is higher than the continuous current limit setting of 6 A. Under this condition, the 12T Accumulator
Variable begins increasing from its initial value of zero. Initially, the output current linearly increases from 6 A
up to 12 A over the course of 1.2 seconds. During this same period, the 12T Accumulator Variable increases in
a non-linear fashion because of its dependence on the square of the current.

At about 1.6 seconds, the 12T Accumulator Variable reaches a values equal to the 12T setpoint. At this time,
the amplifier limits the output current to the continuous current limit even though the commanded current
remains at 12 A. The 12T Accumulator Variable value remains constant during the next 2 seconds since the
difference between the actual output current and the continuous current limit is zero.

At approximately 3.5 seconds, the commanded current falls below the continuous current limit and once again
the output current follows the commanded current. Because the actual current is less than the continuous
current, the 12T Accumulator Variable value begins to fall incrementally.

The 12T Accumulator Variable value continues to fall until at approximately 5.0 seconds when the
commanded current goes above the continuous current limit again. The actual output current follows the
current command until the 12T Accumulator Variable value reaches the 12T setpoint and current limiting is
invoked.
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Figure 2: Diagram B

20.1.2.2 12T Scope Trace Variables

Two Scope Tool trace variables are available for monitoring whether the I2T accumulator is accumulating or
discharging.

« The 12T Amplifier Accumulator variable evaluates the accumulator against the factory set current lim-
its of the amplifier.

« The I12T Motor Accumulator variable evaluates the accumulator against the user-programmed current
loop values.

The value shown Diagram B has been normalized so that 100% equals the 12T setpoint.

When either trace variable line reaches 100%, current limiting will be invoked.
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21 Appendix: Homing Methods

211 Overview

There are several homing methods. Each method establishes the:

« Home reference
« Direction of motion.

21.2 Homing Method Descriptions

21.2.1 Absolute Encoder Immediate Home
Absolute encoder actual position is set to Home

Active Load position is set to zero.

21.2.2 Set current position as home
The current position is the home position.

Actual position is set to zero or to a value that is entered into the "Offset:" position box after "Home" button is
pressed..

21.2.3 Hardstop
Direction of Motion: Positive

Home is the positive hard stop. Direction of motion is positive. In servo modes, the hard stop is reached when
the amplifier outputs the homing Current Limit continuously for the amount of time specified in the Delay
Time.

If a positive limit switch is activated before the hard stop, an error is generated.

[ il

| -®

Direction of Motion: Negative

Home is the negative hard stop. Direction of motion is negative. The hard stop is reached when the amplifier
outputs the homing Current Limit continuously for the amount of time specified in the Delay Time. If a
negative limit switch is activated before the hard stop, an error is generated.

i |

@ |
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22 Appendix: ASCIl Commands/Serial Control

221 Kollimorgen ASCII Interface

An amplifier's RS-232 serial bus can be used by an external control application (HMI, PLC, PC, etc.) for
setup and direct serial control of the amplifier. The control application can issue amplifier commands from the
set of ASCII format commands that make up the Kollimorgen ASCII Interface.

22.2 RGM WorkBench ASCIl Command Line Interface Tool

As described below, the RGM WorkBench ASCII Command Line Interface tool provides a simple way to
enter Kollmorgen ASCIlI commands.

Use the ASCIl Command Line Interface to Enter Commands

1. From the Main screen, choose Tools>ASCIlI Command Line to open the tool.

5]

Command: I

Response:
. i
Close |

Enter an ASCIlI Command in the Command field.
Press the Enter key to send the command to the amplifier. Observe the Response field.

@ N

If a value is returned, it is preceded by the letter “v.” In the following example, the get command was
used to retrieve the amplifier RAM value of variable 0x32 (actual position).

5]

Command: Ig rix3 2|

Response: [v O
. i

Close |

An error code would be preceded by the letter “e.”

* TIP

To view an error definition, hold the mouse pointer over the error number.

For more information, see the Kollmorgen ASCII Interface Programmer’s Guide and the Kollmorgen Amplifier
Parameter Dictionary.

22.3 Single-Axis Serial Connection

For RS-232 serial bus control of a single axis, set the CAN node address of that axis to zero (0). Note that if
the CAN node address is switched to zero after power-up, the amplifier must be reset or power cycled to
make the new address setting take effect.
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23 Appendix: USB to Serial Adapter

23.1 Recommended Device
Kollmorgen recommends using the USB to Serial adapter, part number XX-XXXXX-XXX

23.2 Factory Settings

The factory settings for this device works well, but Kollmorgen recommends changing the Latency time for
faster performance with RGM WorkBench software. This value is changed through the Windows Device
Manager

1. Open the Device Manager dialog from the Windows Control Panel and expand the Ports (COM &LPT)
node:

[+-+4g9 Batteries

g Bluetooth Radios

v CAN Hardware (Kvaser)

M| Computer

¥ ControlVault Device

Disk drives

., Display adapters

# Human Interface Devices

& IDE ATAJATAPI controllers

= Imaging devices

K| Intel(R) Dynamic Platform and Thermal Framework.
> Keyboards

] Memory technology driver

_!, Mice and other pointing devices
+]--Bl Monitors

- [%:twork adapters

= ?’ rts (COM &LPT)

YZ¥ ECP Printer Port (LPT1)

----- ; orolific USB-to-Serial Comm Port (COM16)
Processors

Smart card readers

| Sound, video and game controllers
M| System devices

a Universal Serial Bus controllers

2. Select the COM port that is used by the USB to Serial Adapter (refer to manufacturer's documentation

for details).
3. Right-click that port and select Properties from the pop-up menu. This will open the device properties.

Prolific USB-to-Serial Comm Port (COM16) Properti il

General | Port Settings I Driver I Details I Power Manageme%

Prolific |USB4o-Serial Comm Port (COM16)

Tl
Device type: Ports (COM & LPT)
Manufacturer: Prolific
Location: Location 0 (Port_#0001.Hub_#0003)
Device status
This device is working property. ;I
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4. Select the Port Settings tab, then click the Advanced button.

Prolific USB-to-Serial Comm Port (COM16) P

"General Port Settings |§ri\rer I Ditails I Power Management I

Bits per second: hd
Data bits: m
Parity: | None b
Stop bits: lﬁ

How cortral: lﬁ

Advanced. .. | Bestore Defaultsl

ok | Cancel |

Advanced Settings for COM16 x|

s

¥ Use FIFO buffers frequires 16550 ible: UART)

Select lower settings to comect connection problems.

Cancel |
Select higher settings for faster performance.
Defaults |

Receive Buffer: Low (1) | tghog g

Transmit Buffer: Low (1) I High (18} (16)

COM Port Number: ICOMZ {in use) 'l

5. The factory default setting for Latency Timer is 16 ms as shown above. Change the Latency Timer to
1 ms, No other settings should be changed. Click OK to set the new value and close the dialog.
6. Click OK to close the device properties dialog.
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About Kollmorgen

Kollmorgen is a leading provider of motion systems and components for machine builders. Through world-class
knowledge in motion, industry-leading quality and deep expertise in linking and integrating standard and custom
products, Kollmorgen delivers breakthrough solutions that are unmatched in performance, reliability and ease-

of-use, giving machine builders an irrefutable marketplace advantage.
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